


Illustration Kickstart

Copyright © 2017 by Tony Laidig / Expert Media Group. All rights reserved.

This book or any portion thereof may not be reproduced or used in any manner 
whatsoever without the express written permission of the author or publisher except for 
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contrary interpretation of the subject matter herein. Any perceived slights of specific 
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COMMUNICATING YOUR STORY 

Your book is NOT just about pretty illustrations. This can be a subtle deception: if you can 
come up with pretty pictures, you will have a good children’s book. This isn’t true. The “Why” of 
your story must be effectively communicated, both in the words and in the illustrations. Why 
did you write the story? What do you hope it accomplishes? What is it that you want the reader 
or listener to come away with after they’ve experienced the story? Is it to be educational? 
Affirming? Instilling a life lesson in a clever way? 

You can communicate the “why” in a number of different ways: 

✦ Choice of colors you use

✦ Choice of scenes

✦ Character features

✦ Ways characters are presented.

Depending on your target age range, don’t assume your audience, especially a younger one, 
can understand the essence of what you are trying to communicate. If you are talking about a 
rhinoceros dancing in a tutu, a child might say, “Okay. I don’t know what a tutu is or a 
rhinoceros.” They may never have seen a rhinoceros before and don’t even know what that 
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word is! They will say, “Okay” but you’ve lost something there. The same is true of your color 
choices. You might think a color is pretty, but will a child respond to it? Children’s toys are 
made in primary colors for a reason! You cannot make assumptions with your audience, 
especially a younger one because they have no context, no frame of reference. A good 
illustrator can help you to sort through these elements to make sure you visually represent 
your story to the right audience.  

It is important to understand that some elements of your story MAY need to be rewritten to 
accommodate a better flow of your illustrations and your book. Many people who have a 
children’s book in process have no idea where to break the type, where the story should be 
illustrated, etc. There isn’t one formula, but how you do these things definitely makes a 
difference in telling your story. The way the story came to you originally may not lend itself to 
telling the story that you visually need to communicate, so you could need to rewrite parts of it. 
Don’t become so attached to an inspired story that you aren’t willing to make changes that will 
create something better. Sometimes the problem is that you are too close to see where 
changes would improve what you are trying to communicate. That is why it is important to work 
with a good editor, one familiar with children’s books who understands how to get the flow or 
cadence right alongside the images. 

Your story idea or story itself often comes first. However, for some people, having illustrations 
or photographs as inspiration can spark an idea for a story. You should pay attention to 
discover which works best for you. 

ILLUSTRATIONS 

One of the big hangups in children’s books is determining what you should illustrate. There is 
no decisive “rule” to determine what goes where like “two sentences per page” or “an 
illustration spread across every two pages.” The illustrations should move the story forward in 
the case of a character story and bring to life the characters, setting and mood. They introduce 
the visual “rhythm” of the book; and your character’s design and portrayal play an important 
role in communicating your story. 

In determining what to illustrate, you need to ask yourself what “visual” elements from your 
story could communicate the essence of your story without words? If you had to tell your 
children’s story using no words at all, could you do it? What would those visuals look like? 
Would you lose anything or would the essence of that story, the underlying “why” still be there? 
This is probably one of the most important questions in the entire process.  

Illustration Options 

1. Create your own illustrations. There are some wonderful author-illustrators. It isn’t possible
for everyone.

2. Work with a talented high school or college art student. It helps them build their portfolio,
gives them practice and exposure, and can save you a lot of money. The downside is the
age of the person you are working with. At 17, 18, 20, they are not necessarily going to be
as responsible as someone who is doing this for a living and/or has done this for a while.
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They may be good, but what they value (e.g. time with friends, school work, etc.) might not 
be in sync with what is important to you. 

3. Use photographs either as-is or converted into illustrations. I am not going to spend time
talking about it. I just taught 37 modules on the subject over the last year, so if you want
more information and haven’t taken the Easy Book Illustrations courses, I recommend you
invest in the foundations training we just wrapped up.

4. Work with a Publisher. One of the challenges of self-publishing a children’s book is that you
have to do pretty much everything yourself. Working with a publisher can really save you a
lot of headaches because they know how to do all this and have good illustrators to help.

5. Hire your own illustrator. This can be a bit intimidating. Most of us don’t know where to find
them, how to interact with them, how to pay them, how to handle the situation if you don’t
like the work after it is completed. There are a lot of issues.

There are a lot of places where you can find illustrators:

• word of mouth. This is how I found the two I am working with right now. If you have a
friend who has published a children’s book, ask if they can give you names.

• Online.
- http://www.hireanillustrator.com
- http://www.odesk.com.
- http://www.freelancer.com
- http://www.fiverr.com

Working With an Illustrator 

Illustration style plays an important role. Think about your illustrations and the visual elements 
of your story. Are they effectively communicating the story? I’m not saying “get rid of the 
words.” But, we are communicating on multiple levels, not just the words and not just the 
pictures. It is color, illustration style, visual mood… all of that. A good illustrator can really aid in 
the process because their style will help determine the flow of the book, the look of the book, 
etc. Think it isn’t true? Have two different 
illustrators draw the same illustration based 
on some specifics of your story and see how 
different it looks, feels and reads!  

Look at this illustration (right) by Nancy 
Tillman, a well-known author-illustrator. Her 
work is very photorealistic and her style 
builds off photographs.  

Compare that to this super simple 
illustration (below) about the exclamation 
point with a basic font, no color or 
background. 
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Could Nancy Tillman illustrate this 
book? Of course! Would it look a lot 
different? Definitely. Would the book 
communicate differently? Absolutely! 

The Illustration Process 

If you choose to work with an 
illustrator in the traditional fashion, 
there are a couple of things to keep in 
mind. Each illustrator works 
differently, so this is kind of an 
overview of what you can expect from 
interacting with an illustrator for your children’s book. 

1. Prepare an Understanding Brief. This is your number one priority at the start. You need
essentially to get on the same page. The illustrator needs an understanding of your vision
for the book, color schemes you are thinking about and why, the artistic style you are
looking for, and the message you are trying to convey. You can rely on the illustrators to
come up with concepts, but that has to be part of the conversation right in the beginning.

2. From the first conversation/Understanding Brief, the illustrator will come up with some
basic sketches, layouts, storyboards. They will share the storyboard with you and you will
get a feel for their style and vision for your words or understanding of your vision. If you are
working with a professional illustrator and have done your due diligence, looked at their
portfolios and vetted them, you need to remember they are PROFESSIONALS. Let them
do their job! It is very frustrating for a professional designer or illustrator to work with
someone who “knows it all” because they had a graphic design class in college. When I
was designing book covers, whenever I got to work with an author who knew exactly what
they wanted their cover to look like, I knew it was going to be awful—and it was every time.
Every single time an author got heavy-handed with the design, it turned out to be horrible.
Every. Single. Time. Keep that in mind. These are professionals so get out of the way and
let them do their jobs. I’m not saying they are always going to get it right, but if you chose
someone who is good at what they do, then let them do it.

3. With layouts and storyboard approved, they will then begin to ramp it up to the next level,
the actual visual style you want to communicate.

4. The illustrator will complete a first draft of one or two illustrations.

5. You, the client, will give feedback on the first draft illustrations.

6. The illustrator will make changes and deliver. You do NOT want your illustration process to
go back and forth and back and forth. Don’t micro-manage your illustrator. Be clear and
focused. Sometimes you don’t know what you want until you see it, but you need to figure
that out sooner than later.
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7. In some cases, there will be a need for further drafts, but again, you want to keep this to a
minimum. If you don’t, it is going to cost you more and you will never get your book
finished!

The process will take 6-8 weeks, even if the illustrator is using digital methods. In some cases, 
depending on the illustration style and the number of illustrations you need, it could take 
longer. 

Things to keep in mind 

✦ If your illustrator is using traditional mediums, e.g. pen and ink, watercolor, etc., will they
supply digital versions? You want 300 ppi versions of the illustrations? If they do not, you
may need to scan the final works yourself and that could require a large bed scanner. It is
not something you are going to be able to do with your $60-$70, 8.5 x 11 scanner. There
are services that will do this for you for a reasonable fee, but you need to keep that in mind
and prepare for it. You have to have a way to go from finished work to digital form and
depending on the medium used (like watercolor) there could be some warpage or issues
like that so you will have to deal with those. You cannot just snap a quick photo.

✦ If you are using digital or photo-based illustrations, your final resolution MUST be 300 ppi at
100% of the size to print. In other words, if your book is 8.5 x 11 and your images fill the
page, they must be 8.5 x 11 PLUS bleed at 300 pixels per inch.

CHOOSING THE BEST FONTS: ARTSY VS. READABLE 

Font size is almost always driven by age group. The younger they are, the bigger the font 
typically is. I’m not quite sure why this tends to be a rule since we know these kids can’t read 
at this age, but maybe it is planning for the kids who are bright and can read young or it is 
planning for the grandparents who need to see to read the book to them. 

✦ The smallest font size, 12 point, would be for chapter books, ages 9 and above.

✦ Children’s picture books are typically 16-18 point, sometimes larger. If there are few words
and especially if you are using the words as part of the design elements, you can get away
with a much larger font.

✦ Serif fonts like Cambria or Palatino are most common. You can experiment with other font
styles to accentuate parts of stories when it makes sense. There are times when the font
style you are using becomes part of the story and accentuates something you are talking
about. For example, if your story is a sports story, it may make sense at some point in the
story, to drive home a point, to switch to a font that looks typical of what you would see in
sports-related things like a letter jacket; or if your story is about a bad guy in the 1800s,
they have those old stenciled fonts that they used in Wanted posters and it could make
sense to use that in a particular part just to accentuate the story.

You can also select different fonts to differentiate dialog if needed. If two characters are
talking, you can help the reader know which one is talking by using different font styles for
each. That way, at a quick glance, you know which character is talking.
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Here is an example, a page from a very popular Eric Carle book, The Very Hungry 
Caterpillar. You can see he uses a serif font, simple type in 16 point on a two-page spread. 
The text is presented in a unique way, not blending from left to right. 

Here is another, The Dark by Lemony Snicket. The type is a smaller serif font. Look at how 
they are using the font as a story element. It is the same font, same size, but they are making it 
part of the story simply by using position of the text in the story to communicate with the type 
beyond just telling the story. 
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MECHANICS… 

Book Length 

I’m asked all the time how long a book should be, how many illustrations, how many words. 
The average page count of a typical picture book is 32-40 interior pages plus the cover. 
Typically, a children’s picture book will run from 0-1,000 words, usually under 500 words. For 
example,  
- Flotsam by David Wiesner has 0 words. He tells his entire story visually. There are a

number of illustrators out there who do this, and it is a real talent to be able to communicate
a message in a series of images.

- The Dark by Lemony Snicket is around 500 words

NOTE: Most non-fiction books are much longer in word count, 20,000-30,000 words. Your 
price on a book like that would be $7.99 to $9.99. Compare this to a children’s book where you 
may write 300 words and add illustrations in a fraction of the page count and sell it for the 
same price! 

Layout 

Stick with Industry Standards! This is huge. It really depends on who you are printing with, 
but most publishers & printers if self-publishing have industry standards. They are set up to 
work with that so you are going to get the best price possible and distribution is set up to 
these standards so if you don’t fit, expanded distribution will not be available to you. 

- With children’s books, those sizes are 7 x 10, 8 x 10, 8.5 x 11, 8.5 x 8.5

- A lot of books are done in horizontal orientation like 10 x 8. CreateSpace does not have
the ability to work with this as an industry standard size

Always plan for bleed! Bleed is 1/8” on each of the four sides so that is .125 added to each 
side or .25 added to width and .25 added to height. 

Consider 2-page spreads. Make sure proportions are correct but if you use 2-page spreads 
and 4 of your 32 pages go to front and/or back matter, that cuts illustrated pages to 28 
meaning you need only 14 illustrations. In a 40 page book with 4 pages of front/back 
matter, you need only 18 illustrations. You don’t have to use 2-page spreads and in some 
stories it might not fit. Keep in mind that half of a 2-page spread could just be a frame 
coordinated to the illustration where the text that is related to the illustration will be printed. 
It could still be illustrated as a 2-page spread even though one of those pages is just a 
border around text. What is bleed/page size on a 2-page spread in a book that is 7 x 10: 

7 + 7 + .125 +125 = 14.25” wide by  10 + .125 + .125 = 10.25” high 

Allow 4 pages for front and back matter. This will include: 

- Title Page

- Copyright Page (page 2 on back of title page typically but sometimes in the back of the
book)
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- Dedication Page (almost always in children’s books), typically page 3.

- Blank or Author Page is typically in the back, the last page in the book. It could be
direction to a URL where the reader can download something special from you or a list of
other books by the author or About the Author, etc.

NOTE: normally, page 4 would be a blank page because all text content starts on a right-
hand page. However, If working with 2-page spread, page 4 will often be the left hand side 
of a 2-page spread with the text of the story on page 5, the right-hand page. 

GETTING YOUR BOOKS PRINTED 

You have several options for the printing of your [print] books. This is not an all-inclusive list, 
but the most known: 

1. CreateSpace: prices are much better for full-color books and quality is improving as well.
I’ve printed through them and have been impressed with the quality.

2. IngramSpark works a lot like CreateSpace but the dynamic is a little different. The printing
is being done by Lightning Source which is owned by Ingram. The quality is better and you
have more printing options like hard cover books which CreateSpace doesn’t do. You also
get Ingram’s distribution arm, an opportunity to get your book into 300,000 book stores
including Amazon.

3. Lulu isn’t a great option but it is an option. I used them for one book. They have some cool
options for full color books but are a little pricey. I also find them unwieldy to work with.

4. Blurb is an option I’ve used a number of times for my coffee table photo books. They have
great quality but are definitely the most expensive option. They have their own software
and are easy to use.
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Session Q & A 

Q: Is there a tool to tell you what type of fonts are used in a book? 
A: There is a web site called What the Font, http://www.myfonts.com/WhatTheFont/ where you 
can upload an image and it will identify the font for you. Take a look at their iPad app, Font 
Scout. 

Q: Do you have any experience with Speedy Publishing? 
A: It is probably not publishing at the same level I’m talking about here. 

Q: What binding do you use on your kids’ books? 
A: It depends. Sometimes it makes sense to go the whole hard cover, dust jacket route. I have 
those options with the printers I am working with. Perfect Bound is a common version that 
makes sense. It is a little more expensive than saddle stitch but it looks higher quality and 
more professional. It all depends on your desired end result for the book. 

Q: Do you have a standard writeup for when you are looking for an illustrator? 
A: I don’t. Just be very clear and succinct in describing what you are looking for. 

Q: What is more common today, hard cover or soft cover? 
A: More often than not, when faced with the option of hardback or paperback versions, people 
take the paperback because it is less expensive. Hardcover versions are not infrequently about 
ego of the author—and there are a lot of returns from bookstores. 
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Not long ago, it would have been impossible for me to entertain my passion for creating 
children’s books. Like many of you, I would have been overwhelmed with the idea of finding 
$10,000 to hire a professional illustrator to illustrate my book or have to settle for something 
sub-standard, something less than the illustrations I would want in my book. But, I’ve 
developed some methods using photography, digital editing and “painting” techniques to 
solve this problem and I think you are going to enjoy learning about it.


When you are looking at the prospect of creating a children’s book, you are probably thinking, 
“The story will be easy to write, but how in the world am I going to portray this story in a way 
that children will love?” I’ve been in publishing for more than 20 years, working as a book and 
cover designer. I’ve learned a lot about writing and publishing books. I have 15 books I’ve 
written in various ways, shapes and forms. I’m not going to say that the writing is easy, but 
the biggest challenge with all children’s books is the illustrations. Illustrations are almost 
always the stumbling block. 


Many years ago when I worked for a Christian publisher, we were always getting the latest 
and greatest children’s books presented to us. We rejected nearly every one, not because 
the story was bad or poorly written—some were wonderful stories—but because the books 
either had no illustrations or the illustrations were not good quality. 
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✦ As an author, you must aspire to create illustrations for your book to tell your story visually
in an amazing, compelling and inspiring way. You hope that as the parent reads a child
your book, the child is taken in by the visuals, the artwork that children respond to.

✦ Whether you are writing your first book or producing a series, your illustrations are setting
a standard that can make or break your success. As a children’s book author, your
illustrations define your brand.

✦ It is important that you establish a “look” right from the start that can carry on in sequels,
future projects, product development and more. You don’t know how inspiration is going
to flow. A book you think of as a one-time thing could inspire a series of books based on
the same characters; or a series could inspire an animated children’s program or physical
products like dolls. Of course all of our projects are not going to turn into that, but I’ve
always found that it is better to think long-term and plan big in the beginning rather than
embrace small thinking and have to back-peddle down the road.

The Illustration Process 
So you have a great little story…Whether creating books for Kindle or for print, and whether 
you are creating the illustrations yourself or hiring a professional illustrator to whom you need 
to communicate your vision, there is a process involved in illustrating your books. A lot of 
factors go into the illustration process before you begin to create the actual illustrations:


Illustration PLANNING: What elements of your story should you illustrate? It won’t be 
everything so what needs to be illustrated? 


- Some of this will depend on the age bracket you are targeting. If you are writing a book
targeted at the age 4-8, you are going to have more illustrations than if you are targeting
8-12. Books written for ages 8-12 are likely to have one or two illustrations per chapter
where a book for 4-8 is going to be fully illustrated with full-color illustrations.

- Where are the natural breaks in the story?
- What visuals is your story going to create?
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Illustration STYLE: What “look” are you after? We are talking about your design style. Do 
you want it to be modern? Exaggerated like animals with giant heads and tiny bodies? 
Painterly? Minimalist, etc.?


Illustration COLOR SCHEME: Color palette must be consistent throughout the entire book! 
The worst mistake you can make is to have one illustration look one way, say muted earth 
tones and a few illustrations later have bright, neon-looking one. You have to decide on a 
color palette and stick to it throughout the entire book and/or series. Is that color scheme 
going to be earth tones? Monochrome? Bright, primary colors, etc.?


Illustration MEDIUM: This is often related to style. Each medium has a totally different look 
and feel to it. What is going to fit best in telling your particular story? When it comes to the 
illustration mediums, you have several options:

- Traditional mediums: Acrylics, Gouache & Watercolor are the most common used for

illustrating children’s books
- Computer-based mediums: vector (cartoons),

raster (all digital photos, pixel-based) & 3D art
(modeled using 3D programs)

- Photography-based mediums: photograph
imported into computer and then using digital
art filters (image right). We live in a time when
the software available to us is practically
miraculous. What you can do with even apps
on your phone today were impossible to do
ten years ago. This is a great age for creating
information products, books, and more.

Illustration SPECS: What specifications does your book require? 
- Final Image Resolution: where is your final image going to be? Print? Digital eBook? If you

are going to print, you need to know your page size and your images must be 300 ppi so
image size is going to be page size x 300. If you are going just to Kindle, your image is
800 pixels wide at 72 ppi. With some of the newer Kindle versions, some would argue that
the image could be wider and that is probably true, but if you want to remain compatible
with the broadest number of Kindle devices, 800 wide is a good place to start.
Remember, the bigger the image is, the larger the download size and the greater the risk
of increasing download delivery charges.

- Aspect Ratio: what is your page width vs. your page height. If you are printing, your
illustrations need to match your page size! Unless you are trying to create illustrations that
only take a smaller portion of a page, you don’t want to create illustrations that are
horizontal and then try to fit those into a vertical frame. If you are using Kindle, the Kindle
aspect ratio is 1:1.6 so that means the long side of your page is 1.6 times the size of your
short side.
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- ALWAYS plan for the largest size! Many of you are likely just Kindle publishers who
haven’t done much in print and may even think you are never going to print. First of all,
you should be creating books for print. You cannot take advantage of opportunities like
Amazon’s Matchbook program if you are not creating books for print. Furthermore, there
is something about having a print book, especially for children’s books, and with the color
options available through CreateSpace and other printers, there really is no reason why
you shouldn’t create a print edition for your book. All of this is to say you have to plan for
the larger size. Not only are there different book type options, but you will need web
graphics and Facebook images of your illustrations. There are also ancillary products like
posters and calendars, greeting cards and apparel you can create. If you have amazing
illustrations, chances are good that people are going to want them in a form beyond the
pages of your book. You can take a high-resolution image created for print books and use
it for other products or easily reduce the size for a Kindle device, but you cannot take a
small illustration created for a Kindle device and turn it into a print version or use it for
much else without literally starting over and recreating the illustrations! Can you imagine
creating a book for Kindle that just takes off with thousands of downloads every month
and people asking for a print version when you only have an image 800 pixels wide? Even
if you think you will never create a print version of your book or an ancillary product, you
cannot guarantee you won’t change your mind in the future so always create your
illustrations in the larger size so you are ready for whatever the future might hold.

CREATING ILLUSTRATIONS 

Once you have planned for your illustrations and know what it is you want and need, where 
do you begin to create your illustrations? First and foremost, know and understand your 
options for getting your illustrations produced:


• Draw or paint them traditionally yourself. Maybe you are a talented artist who can draw or
paint your own illustrations. That’s great! That will save you a lot of money and effort in
getting the illustrations to look the way you envision them.

• Friend or family. Do they understand the process? One of the big problems I’ve seen,
especially in illustrations that have people in them, is the illustration of the eyes. People are
difficult to illustrate. Young and inexperienced illustrators very often do a terrible job making
eyes big and goofy looking. It looks unusual and ruins the illustration. Maybe you have that
person in your family, the one who draws all the time or is a trained artist or is an art
student whose work is amazing. That is fantastic news for you. But for most people,
“Suzy’s” doodles are not the kind of a skilled and talented artist that you need for your
brand. Now is not the time to encourage “Johnny” in his illustration dreams if you don’t
have the courage to tell him when the work is bad. This is about your book, your brand,
and you want it to look as good as you can get it.

• Find an art student in high school or college. This is a smart method and can work out
good for you. They are studying art and art styles, they want to build their portfolios, and
very often you can strike a deal with one of the top students who can do your project for a
fraction of what a top illustrator would charge. Just remember, working with students can
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present challenges. Your project is not their top priority, so you will have to manage the 
process and expect delays.


• Outsource. You can always hire a professional illustrator. Depending on the type of art you
want, you may be able to find an artist on Fiverr, but you have to be very picky. There are
not a lot of “professional” artists working on Fiverr because professionals will not work for
those fees, but you can try. Alternatively, you can find and hire a true professional illustrator.
If your story is hot and you think it is going to be a huge seller, you may want to hire a
professional for all the advantages and benefits they can bring to the table; but be
prepared… you will have to spend hundreds of dollars per illustration. it is not unheard of
for a 32 page book to cost $10,000 for a set of illustrations.

• Use photo-based illustrations. As a photographer and Photoshop junkie, I really like this
approach. I’ve been experimenting with it for a long time and teach a number of courses on
how to use the many different techniques I’ve developed. Once you take your photos, you
have lots of options for converting them to illustrations. You need to know how to properly
use the techniques to get a desired end result, but there are a lot of options.

Photo-based Illustrations 
A book published in the early 2000s inspired me along the path to create illustrations from 
photographs. The book, Stranger in the Woods, was a children’s story created by two 
photographers who built a snowman in the woods and over the course of a winter, they were 
able to photograph various scenes like little deer interacting with the snowman. The 
“illustrations” in the book are all photographs. I thought it was amazing that they could use 
photographs in place of illustrations for a book that became a huge best-selling book and 
won a boatload of awards. Once I saw some of the new software technology that was coming 
out where you could turn photos into illustrations, it all just clicked. 


There are basically two methods used to create a photo-based illustration:


- “Live” Photos: the entire scene is shot in picture form, either staged or not. You set up
the scene live, take a photograph, and that picture becomes your illustration, either “as
is” or as a photographic “illustration” using software manipulation techniques.

- Photo Composite: take multiple elements—like multiple photographs, photographs and
3D models, etc.—and bring them together to create the scene in an image editor like
Photoshop. The images below show the basics of creating photo composited scenes.
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The image on the right is a photo composite for a book I am illustrating. The story is based on 
a dog’s interactions with various other animals. The odds are slim that I could photograph the 
dog interacting with a mountain lion in a way that would be acceptable for a child’s book. So, 
for that book, I am modeling the characters in a 3D program (left). I found a photograph in a 
stock photo site that I thought would work good in a particular scene in the story (center). On 
the right, you see the result of me compositing these two elements together and then 
applying some of the illustration techniques I use to get the end result. 


ADVANTAGES OF PHOTO-BASED ILLUSTRATIONS 

Photo-based illustrations change the rules. Photographs are the most commonly used visual 
medium for telling stories. Most people take and use photos EVERY day, especially with their 
phones. Why? Because we see something that is cool or we are having an experience that we 
want to remember, etc. We want to capture those memories so we can share the stories with 
others. And, anyone can take a photo. It may not be a great photo, but I can fix that. On the 
other hand, few can actually draw or paint in a way you would actually want to use in a book.


The process is also fast and puts control back in your hands. Sometimes, you have an idea 
for an illustration but when you see it, you decide it is all wrong or you want to change the 
story and the illustration no longer matches the text. Unlike with traditional illustration, using 
these techniques allows you the flexibility of changing your mind, quickly and often. Have an 
illustrator create an illustration for part of your story, then change your mind and see what 
happens. After they freak out, they will do a new illustration and charge you all over again for 
every time you change your mind. Because the techniques I am showing you are quick, when 
you change your mind about a scene, you can just find a new photo, bring it into your 
software, render it into a new illustration in ten minutes. That is a game-changing, low-cost 
difference. 


POTENTIAL FOR PHOTO-BASED ILLUSTRATIONS 

You may think, “Tony, I don’t want “photographs” in my children’s books. That isn’t the look I 
want.” Great! There are so many different possibilities for using photos to create unique 
illustrations that you don’t have to just take a picture and slap it onto a page in your story.


Lately, I’ve been looking at the work of best-selling children’s book authors and then 
developing methods to create digital styles inspired by the illustrations in their best-selling 
children’s books, illustrations from the likes of Dr. Seuss, Eric Carle, etc. Let’s look at some 
examples of illustrations I’ve created using this method. The images below are illustrations 
that have come out of my training course where I teach these methods. They represent a 
wide, varied set of styles because one style is not going to work for every book. 


The image below left is inspired by the work of best-selling author/illustrator, Eric Carle. It is a 
photo composite of two photos that were cut apart and then, after applying filters to them, 
were re-composited together again. The image right is a 3D rendered dog over a photograph 
with a variety of different filters applied to the composited scene.
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The image below left is inspired by the work of Nancy Tillman.


In the images below, the image left is a raw photograph of one of our family dogs completely 
processed with a little hand-drawn elements added to it. The same is true of the image on the 
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right. This is a multiple illustration technique compiled together, but the foundational image for 
this is a photograph I took a couple of years ago.


The lush illustration below is based on a photo I took in Savannah, GA. On the left is the entire 
illustration. On the right, I zoomed in so you could see how cool this looks. It has the look and 
feel of a watercolor painting. There are about ten to twelve specific steps you have to follow 
to get this look, but it only takes about 20 minutes and the end result is pretty amazing.


Below are two more images of covered bridges to give you an idea of the variety of styles we 
can create. The bridge on the left is the same bridge as above but with a different, engraving 
style while the one on the right is more of a watercolor technique. 


Illustrations, regardless of the method you choose to use, will be comprised of two things: 
scenes and characters. I now always approach the illustration process using the photo and 
photo composite option, but photo-based illustrations require photos, photos for scenes and 
for characters. To be more accurate, they require images of any kind because the same 
techniques can be used with line art or models the same as with photographs. I will refer to 
these as “Image assets.” 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FINDING IMAGE ASSETS 

Some of you may be saying, “Photos? You are a photographer, Tony. You can take the photos 
you need so it makes sense for you to use this method.” True, but it is important to make 
clear that the photo-based illustration process doesn’t require you to be a professional 
photographer to take your own photos. You don’t have to make it difficult, and the fact is, you 
have a number of different options for getting your foundational image assets. In my Easy 
Book Illustrations courses, we look in detail at all of the following sources of image assets and 
how to use them in creating illustrations:


• Photo composites using your own or purchased photographs
• Public Domain/Royalty-free clip art
• Public Domain book art
• Public Domain comic books
• Public Domain patents
• Public Domain coloring books
• 3D modeling
• Photographing miniatures

Let’s take a look at a few of these options…

TAKING PHOTOGRAPHS

I think you will be surprised to learn what is required for taking your own photos when you are 
going to convert to illustrations.When it comes to gear, you don’t need $1,000 cameras. I 
have students who have created some amazing illustrations using nothing more than their 
point-and-shoot cameras. Using high-end cameras comes with some benefits because of 
things like control over depth of field, exposure, etc. but nearly ANY camera, including smart 
phones will work. Start with what you have and don’t let the camera be an excuse for not 
getting started.


More important than the specific camera you 
use is the macro lens. For many of the photos 
you want to take, you are going to need to be 
close to the characters, especially if you are 
doing just a head shot of a three inch character. 
A camera with a macro lens or 
macro setting (circled in image) 
is ideal because it enables you 
to get closer.


You can also use extensions 
tubes (image upper left) to 
increase the distance from the 
camera sensor to the back of 
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the lens which means you can focus at a much closer distance than you could without the 
extension tubes. Most extension tubes are inexpensive and are available for pretty much any 
camera on the market with interchangeable lenses.


Other options for close-up shots include close-up filters (image lower right) which just screw 
on over your lens. They are available in different sizes depending on the particular thread size 
for your lens; macro bellows (image lower center) which work basically like extension tubes 
but because they are on a track, you have a lot more flexibility; and even macro bands and 
lenses available for your phone.


A tripod is generally a great idea, particularly when photographing miniatures. Unless you 
have a lot of light, in some cases you are going to have to make your exposure time longer to 
get the highest quality photograph, something you need to always try for. Longer exposure 
times are very difficult without a tripod.


Of course, more light is better. More times than not, I use the sun. It is the best light source 
we have—and it’s free. If you are shooting indoors, very often you can set up near a window 
that gets a lot of sunlight to take advantage of the sunlight. If you need to supplement 
lighting, you can use a basic lighting setup with work lights you can buy at a home center, or 
you can invest in a more flexible setup including a light tent and photo lights. This gives you a 
more even light without harsh shadows. Unless you are going for that look, shadows can be 
hard to work with in compositing, so avoiding them can save you some hassles in post.


Let’s look at a “behind the scenes” photo of how I photograph miniatures and the end result 
to see what I’ve done with some of my miniatures. In the image below left, I’ve used a white 
blanket on the couch, some fake snow and Christmas decorations/accessories. I shot this on 
Christmas day right in my living room. The light is coming from the sun entering a big bay 
window in the room. The only piece of “high tech” equipment is the light stand used to 
suspend the little guy and hold him still so I could use a longer exposure. For this particular 
photo, I am using a Fuji Film XT1 mirrorless camera, 56 mm 1.2 lens (about the same as an 
85mm on a standard DSLR) on a tripod. From the basic setup, you can see I got a pretty cool 
image (right).
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COMIC BOOKS 

It is not secret that I love the vast content available in the public domain. From clip art to 
coloring book art to art from old books, the public domain offers a magnificent resource for 
finding image assets we can use freely. 


Why would we want to use old public domain stories? Ask Disney. The company has 50+ 
major motion pictures, pretty much their entire animated classics library, including Frozen, 
Tangled, etc. that are all based on public domain stories or characters. They’ve made billions 
of dollars from it.  


A big secret of mine is comics. I love comics. You can tell stories with comics in some very 
unique ways. What you may not have known is that there are over 17,000 comics in the public 
domain. That means we have access to great stories and a lot of great art, and we can 
repurpose those stories and artwork however we see fit because they are in the public 
domain. 


One of my favorite places to go for public domain comics is comicbookplus.com. Below left is 
a typical screen shot of an image from this site from Alice in Wonderland. I think you will agree 
that the quality isn’t very good at all. It looks nearly unusable. But with a few minutes and a 
little work, you can change it into something that looks like the image right, a totally usable 
image for illustrating a children’s book.


Or, take another example, an image (below left) that is not only difficult to work with because 
of the halftone dots but has been yellowed with age. Using some of the techniques I teach for 
working with this type of image, you can turn it into something cool like the image below right. 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Or, how about taking a similar 
comic book image and turning it 
into something like this: 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Characters 
In my Easy Book Illustrations courses, I teach about many different ways to find characters. 
Personally, I like working with miniatures which may be the perfect answer for you in creating 
character-based images.


The images below are from a coffee table book I am 
working on right now. In all these photos, I used 
miniatures I found in a gift shop with toys and even 
garden sculptures in the creation of the scenes. I 
photographed them using both the outdoors and a 
tabletop light tent. After photographing the scenes, I 
can apply some of the illustration techniques I use 
and teach to get wonderful illustrations like the 
sledding scene right. 
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WHY MINIATURES? 

It’s no secret that I like miniatures. Using miniatures in storytelling isn’t a new idea. It has been 
around for a long time. In fact, a number of production companies in Hollywood, including 
Disney, have used miniatures to create entire movies. They are using stop action to create the 
movie but the idea is the same: using tiny characters in a little set and photographing them. It 
is a great way to make a fantasy movie and it is a great way to illustrate your book. 


If you’ve ever seen any of the Lego books, the characters in the illustrations are all created 
using Legos™. The company sells package kits of the same pieces so the reader can re-
create the characters in the scenes and use them to tell stories based on the characters in 
those kits. It is a brilliant marketing strategy!


Traditional illustrations allow for the artist to create fantasy worlds and stories not limited by 
reality or concept, but chances are you and I just cannot draw and paint like that. The number 
of people who can is very small compared to the number of people who want to create 
children’s books. So for the rest of us, miniatures are a brilliant option affording us that 
opportunity to create fantasy worlds that we can then capture in photographs.


One of the biggest challenges in working with traditional art is control. If an artist creates 
something for your story and you don’t like it or you can’t communicate adequately to an 
artist your vision to get exactly what you want and he/she creates something that isn’t a good 
fit, chance are the artist is going to have to start over or you are going to have to use a 
different artist. Either way, you will incur additional cost. 


Photographing miniatures as a foundation for your illustration gives you full control over the 
end result. You set up the scene and take a photo. If you don’t like the angle, you move the 
camera and take another photo. If you want the scene to be a close up, you zoom in closer. 
Want the character in a different position? Move it and take another photo. Need a photo of a 
winter scene in the middle of July? You can make it snow and create a snow scene on your 
dining room table if you are using miniatures. The control is incredible.
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Another thing I love about photographing miniatures is you can create a library of image 
assets. You can recycle and re-use elements over and over again for different shots, angles, 
scenes and even different books, either in a series with the same characters or in a totally 
different series. A tree is a tree is a tree. If you buy miniature trees, you can use them over and 
over again in your scene set-ups. You can use your characters again and again to create a 
series of books based on the same characters by just placing them in different scenes. The 
characters will always have the exact same look and feel because they are the same 
characters, something that is difficult using traditional illustration methods.


And when you use miniatures composited into scenes or photographed into scenes you 
create on a tabletop, there is no travel necessary to get that perfect shot. But if you do travel, 
it is easy to photograph miniatures anywhere! I have a series of characters I work with that I 
have photographed all over the country. They are small and fit easily in my suitcase. Many of 
the photos were shot outdoors with what was available to me at the time.


When it comes to the illustrations, is easy to illustrate your stories using miniatures because:


✦ It is one of the fastest ways to illustrate your book. You can literally illustrate a book in a
day.

✦ You are not limited by high-end camera gear. As a professional photographer, I have it all,
yet some of my favorite photos I have were taken with my iPhone.

✦ You can use photographs as-is or convert them into illustrations using paint programs.
One of my personal favorites is GMX PhotoPainter, http://gertrudisgraphics.com, an
inexpensive but effective program. You actually paint brush strokes in a way that is like
cloning and you have a lot of control over brush strokes, density, etc. It gives you a lot of
flexibility. Below is an example of one of my images in the painting process using it.
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INSPIRATION FOR MINIATURES IMAGES: 

For years, I’ve wanted to shoot a series based on characters. I’m not a copycat and just 
couldn’t find the character figure I wanted to use, but I followed others who were 
photographing characters. Some are kind of hit 
or miss but I was inspired to work with 
miniatures by a couple of series: 

✦ http://stormtroopers365.com: this guy
shoots photos of Storm Troopers and Star
Wars figures. I have been following him for
a while, and love his work. He is brilliant
and very creative.

✦ http://box-life.tumblr.com: is another I
follow. I was so inspired by the over-the-top
brilliant photography this guy does using
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Amazon box figures that I had to buy one. I used it in one of 
my photographs of the Viking boy talking to the Amazon 
box boy. 

Then, I discovered the Viking figures in a local Gettysburg 
store, Gallery 30. They can also be found at 

http://www.scandinavianshoppe.com 

WHY MINIATURES? 

It’s an exercise in creativity! Yes, it is a lot of fun to come up 
with the photos, but more than anything, this forces me to be 
creative in setting scenes and telling stories. Using figures, you 
can: 

✦ tell character-related stories

✦ shoot random “out of character” photographs of them in funny scenarios

✦ shoot photographs around specific themes

✦ reconstruct famous scenes from photos or movies
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✦ Use them in stop motion videos if they are the right kind of figures (i.e. articulated)

WORKING WITH FIGURES: 

There are numerous series of miniatures and small figures in the marketplace that you can use 
for your creative projects. Even Walmart and Amazon have their own brands of generic figures 
or miniature character toys. You can also create your own, and Etsy is full of examples of 
figures created by crafty people. There are some key issues you need to address: 

Are they trademarked? You need to make sure they are not if you are going to use them for 
any kind of commercial product, e.g. books, posters, calendars, etc. 
Are they articulated (posable)? Getting certain shots is a lot more challenging if they don’t 
move.
If not articulated, do they come in various poses? This can, at least, make it easier to get 
some of the looks you’re after.
Do they come with ready-made accessories? Playmobile toys have a nearly endless 
number of accessories, for example.
Are there other accessory options, specifically for these characters or available in generic 
lines that would work with these characters.
Scale isn’t always necessary. You can create forced perspectives and STORIES! When 
building scenes, it isn’t as much as about scale as it is about whether things look right.
Can you create your own? 

SETTING UP SCENES 

You can find props anywhere if you keep your eyes 
open. In the image right, the kids are standing on a 
piece of what is essentially Spanish moss mounted 
on a flat sheet and colorized. It was purchased from 
the craft store. The little camera was a tiny thing that 
came on a key chain.  

Good resources for Props: 

✦ Craft Stores: Hobby Lobby, Michaels, etc.

✦ Retail: Target, Walmart, Lowes, Dollar Store or
Dollar Tree

✦ Specialty: toy stores, gift shops, Christmas ornaments, pet/aquarium supplies

✦ Vintage: antiques, flea markets

✦ Online: Amazon, ebay, specialty sites.
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✦ Model railroading supplies stores

✦ Architecture model supplies

✦ Garage sales and thrift stores

✦ The great outdoors!! You can find all kinds of stuff outside: rocks, grass, seedlings…

This is a selection of various props I have 
been using for my photographs. You can 
see from the little treehouse that I couldn’t 
fit my characters into that if I tried. But, I 
am still able to use it in my character 
scenes. All the stone and other pieces on 
the right came from the garden section of 
Hobby Lobby. They have a section in 
there for making fairy gardens and 
gnomes. These were all part of that 
collection. I found the skateboards at a 
Dollar Store, a great place to find props. 
I’ve also used Christmas ornaments 
which are great resources! There are 
resources everywhere! 

PHOTOGRAPHING SCENES 

Best Equipment 

I have high-end equipment and I use it, but it has nothing to do with the photos I am getting. I 
am using a Canon 5D MKIII, but you can get the same results from a $200 camera and maybe 
even your phone. Nearly ANY camera will work.  

Macro lenses are ideal in most cases. The smaller the f-stop, the better. I’m using a Canon 
100mm f2.8 

If using a point and shoot camera, you need to use a macro setting. Depth of field control 
and close photography is important to getting these to look realistic.

Get down on the characters’ level!!!!!! This is critical in making these look realistic. You must 
think of your scene as a question: “how would this scene look to the character down at their 
eye level?” Whatever the equipment, you need to be down. If you can, set up your scenes 
on a table so you can more easily photograph but if you need to have them on the ground, 
you need to plan to lie down.

Unless you are going for some type of low-light effect, getting the lighting right is the 
number one thing you will do to get the photography right. That is ultimately what 
determines how good your photograph is. Sunlight is best but nearly any lighting will work 
when used correctly. Inside, fluorescent or LED Ring light (right) is good because it is round 
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and doesn’t create huge shadows. You can also shoot through the 
center hole to get very soft, even lighting. It makes for very good shots 
inside.

Don’t let equipment be an excuse for not doing this. Most of the shots I’ve 
done, I’ve taken outside in my yard while laying on my stomach.  In the 
following images, you can see my exact set-up for the shots. 

OUTDOOR SHOT: I put a tarp down on the ground in my back yard, lay 
down at about 1 1/2 feet from the characters. You can see my camera on 
the ground for the photo. 

OUTDOOR SHOT: This set-up shot was taken with an iPhone with a paving stone under the 
characters at the edge of my driveway. For the final shot, I lay on my stomach to take the shot 
with my Canon. You can see how the entire background of my house and yard is totally out of 
focus where it isn’t with the iPhone. That is the difference the depth of field makes in the final 
photo result. It makes a huge difference. 

SETUP RESULT

SETUP RESULT
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INDOOR SHOT: I set up the characters on my dining room table. The “fence” was a wire file/
mail separator I got from the office supply store and the skateboard is superglued to it. The 
photo was shot through the center of a ring light positioned to give me the appearance that it 
was shot with a flash because that is the way you see most skater photos taken. 

This is another behind-the-scenes image taken in my dining room with a ring light. This time, 
the shot was not taken through the ring light but it was still used to light the scene. Good 
lighting can really focus attention on the characters themselves 

SETUP RESULT

SETUP RESULT
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Indoors vs Outdoors 

Indoors (left) gives you more control over variables. You never have to worry about wind or 
rain, a wet ground or the position of the sun; but outdoors (right) provides amazing light! What 
you see here is essentially the same shot but you can see a definite difference. The colors on 
the outdoor shots are much more realistic. 

These are some of my favorite images of these characters.  

Virtually none of these shots have any post processing treatment. For the most part, it was all 
done in camera. Almost all of these were shot with f2.5 or f5.6 depending on the amount of 
depth of field needed. They were all lit and set up with the camera white balance properly 
adjusted. There really was no need for Photoshop, etc. It comes down to knowing your camera 
and how to use it rather than using auto settings.  

Here is how I created each of these: 

✦ Little girl snow angel: I used my finger to move the snow around and then just pushed her
into the snow. It was shot fairly early in the morning which gave me a lot of contrast in the
light. I wanted that to help define the snow angel part. Had the light been higher in the sky
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(i.e. later in the day). you really wouldn’t have been able to see the definition of the snow 
angel at all. 

✦ Little boy on toboggan: Toboggan is a Christmas ornament. I cut a piece of red felt for the
red scarf and put him on the ornament. I went outside, again fairly early in the morning and
noticed the sun was casting some great shadows from a Rose of Sharon bush in the snow
on top of my Mustang. I set the boy flat on top of the car in the snow and just angled the
camera to give the appearance he was going downhill. He is positioned perfectly so that
light coming through one of the branches in the bush was lighting his face.

✦ The Stonehenge image: I took the three little stone shapes I got from the hobby store, and
put them just behind the boy in my yard. You can see it has a very warm, appealing glow. It
was shot in the late afternoon to get this appearance, and literally took two minutes to set
up and shoot.

✦ Box and boy: I took some Amazon boxes I had at the house, stacked them up, put the
characters up on them and shot the picture. Again, it was a two minute set-up and shot.

✦ Shadow image: This was an accident, a total fluke, and I love it. I was working at my
computer and the power went out. I have a big flashlight and placed it on the table to do
something. It was casting shadows over on the wall so I was playing around making hand
puppets, etc. I grabbed the little boy figure and was dancing him around. That is when it hit
me that I could get a cool photo out of this. I set up a table with the little Stonehenge
platforms on top and set him up there. This image was literally shot with the light from a
flashlight! The power was still out in the house. I just increased the ISO on the camera to
about 1600 so I could get a decent hand-held exposure and took the shot. Had the power
not gone out in the house, I probably never would have gotten this shot. You need to be
creative under pressure!

✦ The skater: we talked about this set-up above. This took some research. The last thing I
wanted was to take this photo and then have someone look at it and say, “A skater would
never do that.” If I am going to shoot a shot of a Viking kid doing a skateboard maneuver, I
want it to be a legitimate skateboard maneuver. So, I had to do research to find out the
positions of the skateboard on the rails, the position of the skater on the board, the position
of their arms when they are doing it, etc.

USING IMAGES FOR A STORY 

For on-going daily photo purposes, it is a good idea to keep a shot list, a list of photo ideas you 
can draw from. There are going to be times you get more than one idea in a day and other 
times you are not going to get an idea. Having a shot list lets you draw from it to take photos 
when you want to set up something to shoot.  

If you are working on a story, it is important to know where you are going in your story before 
you take photos. If you take all your photos out of sequence, taking whatever works in the 
moment, you need a very clear picture of the end result you are trying to achieve and of the 
scenes to be included with your story. If you don’t have this very clear in your mind, you need 
to have at least a basic story board showing what you want to accomplish in a particular shot. 
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Those are all actual photographs but I’ve also been experimenting with illustrations made from 
these for a book. You can use any 
of the methods I’ve been teaching 
in Easy Book Illustrations to turn 
these into illustrations. These were 
made with a software app I’ve 
never taught before though I 
probably will at some point. It allows 
you to create an oil paint effect that 
follows contours and direction with 
your brush strokes but lets you 
control detail so you can add more 
where needed in the scene, like on 
facesI am not going to show details 
of how I am doing this, but here are 
some of the illustrations I am 
working on: 

Important Tips:
• Watch for trademarked products and logos. If they are, you cannot use them.

• Consider making your own characters. You can create models, scan them and turn them into
3D objects, pose them in software like Poser, print them yourself with 3D printers, etc. There
are a lot of different ways to make characters and accessory parts. There are some great
videos on YouTube where you can watch behind the scenes how they shoot stop motion
videos and it can really inspire your creativity.

• Articulated characters are MUCH easier to work with.

• Experiment! It is a lot of fun. 

Illustration Kickstart

36



Session Q & A 

Q: Where are you finding miniatures at Hobby Lobby? 
A: Most of what I’ve been using is from their Spring Garden section 

Q: If you make your own characters, aren’t they copyright protected? 
A: No. Copyright is for print and you cannot copyright the physical objects. You can copyright 
the images of them you put into print, but not the physical characters. Those would have to be 
protected by patent (highly unlikely) or trademarked. 

Q: How do you check the trademark of something? 
A: Go to US Patent and Trademark office web site: uspto.gov 

Q: Where do you get ring lights? 
A: Search “ring lights” at Amazon. 

Q: How do I use my old photos? 
A: Scan into Photoshop at 600 dpi. 

Q: When down on your stomach, do you use the viewfinder or lcd to set up your shots? 
A: It depends. You should always shoot from the perspective of your character, at their eye 
level, especially if using them in a children’s book. There are times I cannot get myself low 
enough to use the viewfinder when using a 3 inch figure so I have to use the lcd. 

Q: Can you explain more about the parallel methods you use to bridge creativity in business? 
A: It takes on a lot of levels. If you are in a group of people and they are all yawning, it is only a 
matter of time before you start yawning. If you spend time surrounded by people who are 
super smart and inspiring, chances are you are going to get inspired. Creativity works the 
same way. If I am using my creativity in one area—like coming up with ideas for these Viking 
kids—in the spirit of creativity, I find myself spontaneously being creative in other areas of my 
business like coming up with new business ideas, solving a problem I’ve been struggling with, 
etc. It is like priming a pump. It’s about creating new neural pathways in your brain. 

Q: Do ring lights work well to shoot photos of printed art work like paper collages? 
A: It depends on whether those have any kind of reflective surfaces. They may work well 
because you get even light. They are excellent for doing portrait work. 

Q: With the ring, do you photograph through the middle? 
A: Sometimes yes. You can move it around and position it and turn it because it is on a 
bendable arm. I sometimes shoot through it and at other times under it or to the side, etc. 
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FINDING MINIATURES 

When it comes to miniatures, one question always comes up: “Can I use any toy or 
miniature?” No, you cannot. Some are protected by copyright and/or trademark. You cannot 
use popular, trademarked characters! Any brand you recognize like Disney™, Warner 
Brothers™, My Little Pony™, etc. is totally off the table. But, you still have a lot of options.


One of my favorite options, Etsy, will become your new best friend. There are countless 
examples there of little dolls and characters. Just do a search on Etsy for “robot.” You will get 
250 pages of results, so when I tell you there are a lot of potential characters on Etsy, I mean 
a LOT. And the craftsmanship is first-rate on many of these. Look at this example of a little 
robot that came up in my search. It is as cute as can be and there are a number of different 
robot characters in this series. These could easily make wonderful characters in a children’s 
book series. The artist even has a pattern you can purchase and download as a .pdf to make 
these yourself.
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You cannot just pick anything from Etsy and use it, however. You need to ask permission and 
not everyone will give it to you. I have to say though, I’ve had a lot of success talking to 
people who make little miniatures on Etsy, at craft shows, etc. Every time I’ve asked someone 
if I can use their little toy or character to illustrate books, they’ve said “Yes.” Every single time. 
That includes some bigger manufacturers like Melissa & Doug, Safari Ltd., etc.


You have a number of other options for finding these miniatures, including:

• You can commission an artist to make them for you.
• You can make the miniatures yourself if you are crafty
• Find cheap, generic, Chinese-made toys at The Dollar Store or similar store
• Find generic characters in craft stores and hobby centers.

CREATING SETS

Of course, if you are going to photograph miniatures, you need sets for them. Whether your 
story takes place in a house, in the woods, under water, or in outer space, your characters 
need some kind of sets to be positioned on if you are going to photograph them for use in 
illustrations. 


Scenes can be created in the great outdoors or indoors using found objects, landscape 
scenery for model railroading, play sets, craft supplies, generic Christmas decorations and 
generic pieces from Christmas villages, etc. Look around your house. You will be surprised at 
some of the things you can turn into components of your miniatures scenes.


One of the big differences between photographs and illustrations is the level of detail. One of 
the things I teach throughout all my Easy Book Illustration trainings is “reduce, reduce, 
reduce.” Reducing detail is the name of the game when converting photos to illustrations. So, 
you don’t have to build a lot of detail in your sets like you see in the elaborate scenes of stop-
motion video.


Below are a couple of examples I’ve created using miniatures. The examples below are just 
little sets I made for fun, not for commercial use. The image left was set up in a light tent in 
my basement and the one on the right was taken outdoors.
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Scenes: Using Hollywood Secrets 

When we think of illustrating our children’s books, we usually assume that for a 32-page 
book, the industry average children’s book size, we will need around 28 different illustrations. 
If you are planning to have your book illustrated by a professional, you are probably sweating 
right now with the thought of the cost for 28 illustrations. But, even if you are going to 
illustrate the book yourself using one of the methods I outlined earlier, you may still find 
creating 28 different illustrations to be daunting task. 


What if you didn’t have to “create” all 28 illustrations from scratch in the traditional sense? 
What if you could create maybe four or five scenes and yet still be able to create all 28 
different illustrations the way Hollywood does for animated films?


For 100 plus years, Hollywood has been creating cartoons using specific methods. If you ever 
watched Saturday morning cartoons or other classics like Winnie the Pooh, The Jetsons, 
Bugs Bunny, etc. you’ve seen their secrets in action. 


Historically (it doesn’t work like this now), 2D animation techniques work with two parts: 

1) The Background which is usually traditionally painted, generally acrylics, gouache or
watercolor.

2) The Cel where characters are hand-painted on clear acetate which is positioned over the
background. A separate cel or layer is created just for animation of eyes, mouths, etc.

To get the movement in the characters, the cel would be repainted with a different character 
position. The background remains the same throughout numerous scenes but the cel is 
changed over the background to get a completely different look. To simulate a character 
talking, only the cel with the mouth changes. 
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You have to think that after 100+ years of creating tens of thousands of cartoons, all the 
studios like Disney, Hanna Barbera, etc. created some methods that would save them time 
and effort. After all, Hollywood 2D animation can require more than 50,000 cels for a full-
length movie! Time and work requirements would have demanded the most efficient methods 
possible because they wouldn’t want to take five years to do a 30 minute cartoon.


What if we could borrow some of those scene building and animation techniques used by 
Hollywood to dramatically speed up our illustration creation process for our books? We can; 
and it will save us a LOT of time when it comes to illustrating our books.


Again, think about the specific factors:


• The backgrounds are static while the animation is created from the cels.

• Larger backgrounds are created so that close-ups, camera pans and pull-backs are
possible.

The image below top is an example from Bambi. Image bottom is a watercolor background 
from Winnie the Pooh. Notice the backgrounds are long, multi-page/canvas images put 
together to use for the cartoon. One background represents multiple scenes, and the 
characters move throughout the area depending on the scene.
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You wouldn’t see the entire background in every scene. You would see closeups of a specific 
area in the larger, overall background and the characters would play out their scenes in those 
close ups.


Let’s look at a specific example in closer detail. The example below is a scene from the Bugs 
Bunny cartoon, Hiawatha. This is the entire background scene that was created for a segment 
of that cartoon. I went to the cartoon and pulled some screen captures off to show you how 
they use this one background to create an entire sequence of cartoons. 


Each of the images in this sequence looks like a different 
illustration, but when you look at the larger background, you 
can see they are all part of the same painting. The animators 
only had to paint one background in order to create a 
sequence of images. Below are different examples—Bugs 
Bunny and Mickey Mouse—of the same kind of sequences 
using different character positions over a single background.


Illustration Kickstart

42



These are the exact same methods Hollywood uses to create books that go along with their 
movies and cartoons. They simply pull out scenes from the animated film and use those as 
illustrations for the book.


It is possible for us to use this exact same method to create illustrations for a children’s book. 
I teach an entire course on just this topic and the multiple ways to create these scenes. 


Let’s put some of this information together into a step-by-step 
demonstration to show you how I create illustrated images for a children’s 
book using miniatures along with a large, Hollywood-style painted 
background scene… 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Demonstration: Composites… Hollywood Style 

In this demonstration, the entire process is as follows: 1) photograph miniatures (Ninjas); 2) 
Silhouette the miniatures in an images editor (NOTE: I will be using Photoshop, but you can 
use another image editor if you prefer); 3) create a background scene; and 4) combine the 
miniatures with backgrounds to create an illustration.


STEP 1: PHOTOGRAPH THE CHARACTER  

For photographing your miniatures, I recommend the following:


✦ Photograph the miniature in five positions as shown in the image below. This allows you to
have the minimum number of positions needed to simulate walking and other movement,
communicating with other characters, etc. You can reverse the image(s) when needed.

✦ Take your photos against an even-colored background. This will make silhouetting them
much easier.

✦ Don’t make it harder than it has to be.
You don’t need fancy equipment. In
these images, I used a blue index card
from Walmart, light from a window and
my iPhone. Even light with minimal to
no shadows is the most critical thing. It
will make a huge difference in the
quality of the photo and your ability to
silhouette the image quickly.

✦ Silhouette (i.e. remove the background
so you have only the character with a
transparent background) the image in an image editor of your choice. I use the
professional’s choice, Adobe Photoshop.

FRONT 1/4 TURN SIDE 3/4 TURN BACK
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STEP 2: CREATE THE BACKGROUND 

The background is a series of image assets I have. I’ve simply used a variety of elements— 
each on a different layer in Photoshop—to combine together and create the scene. By turning 
on and off the various layers, I can completely change the look of the background (see 
below). Each one is similar and feels as if it is in the same area because the style and color 
scheme are the same, but look closely and you will see that each is also different and makes 
the image look like a different scene. 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STEP 3: SILHOUETTE THE CHARACTERS 

In any image editing program, you should have a number of options—magic wand, polygonal 
lasso, etc.—for speeding up the silhouetting process so you don’t have to take a lot of time. 


1. Photoshop has a tool called the Quick Selection tool which I like a lot. This tool works on
averages, so using a small brush and dragging across the blue background while holding
the left mouse button down, it selects the background color. The more I drag, the more it
selects.

2. Sometimes, it gets too aggressive in the process
and selects things I don’t want selected like part
of the character (right), but by holding the
«option/alt» key down while dragging the mouse
across the part I do not want selected, it will
subtract that part out of the selection. It is a little
bit of trial and error, but the more I repeat this, the
more the tool “learns” about what I am trying to
select and the more accurate the selection. I think
you will agree this little trial and error can save
you a serious amount of time.

3. Shadow areas can be a little tricky. Pay
attention to that. The easiest way to
prevent complication with shadows is to
eliminate shadows with your lighting
when you take your photograph.

4. Once I’ve finalized my selection through
this little bit of trial and error, I will have
all the blue selected. I want the ninja girl
selected so I invert the selection: Select
> Inverse (or «command/ctrl» «shift» «I»)
> copy > paste (creates a new layer) >
turn off the background (right).

5. You will notice there is a little bit of
fringing (blue color from the background
left over on the edges of the image) on
the image. There is also a bit of a cast
to our ninja girl because of the blue
background. I could have used green
screen software, but this is easier. To
address the fringing, with the ninja girl
layer selected > Layer > Matting >
Defringe and change the value to 2px.
This will average out some of the edges
and get rid of the fringe.
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6. I still have the blue cast to remove: Image > Adjustments >
Selective color > choose cyans in the drop down list and
turn the cyan slider to zero. The cast pretty much goes
away. Do the same thing choosing the “Blues” in the
dropdown menu, and the blues go away but there is now
some magenta in there. Turn magenta down with the blue
and cyans selected and the color casts go away (image
right—NOTE: a white background has been added to make
it easier to see the change).

STEP 4: COMPOSITE THE IMAGES 

1. With ninja layer still selected, left mouse click the ninja with
the move tool (arrow) selected and drag the character over
to the background document tab and position onto the
scene. She is big so Edit > Transform > Scale to get corner
handles > drag handles while holding down the «Shift» key
to proportionally scale her to fit (see image below).

2. Shadows are a normal part of life when there is light
shining on a person or object, so for this scene to
look more realistic, a drop shadow makes sense. My
quick and easy way to make a drop shadow is as
follows: With ninja layer selected, duplicate the layer
(«command/ctrl» «J» or drag layer down to the icon
next to the trash can) > lock the copy layer > fill
locked layer to black (locking layer ensures the fill will
go only where there are pixels not in the surrounding
transparent area) > unlock layer; Edit > Transform >
Distort to distort layer & flatten as a shadow; Filter >
Blur > Gaussian Blur at around 9-10 px.

3. Shadows are not completely black so go back to the
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shadow layer (name your layers as you create them so you can find them when you need 
them!). The default blend mode in Photoshop and other image editors is “Normal.” I want 
to change the blend mode to “Multiply” and turn 
the opacity down to about maybe 70%. Using the 
move tool, I can further position the shadow to 
where it needs to be for a correct light angle in the 
scene.


4. With the two ninja layers selected, I can pick up
the ninja and move her and her shadow anywhere
in the scene. I can also copy her and her shadow
onto another background to get a completely new
set of scenes.

5. Just with this character, I can create several
illustrations for a story I’ve written. If I am doing
an 8x8 book, for example, I would just crop a
scene to a square, save as Illustration-1. Then I
can move the ninja and her shadow in the scene,
crop again and save as Illustration-2, and so on
(below). In minutes, we can create four or five
images just from this one background by moving
the ninja in the scene and cropping the image. If I
had to have an artist paint those four or five images, it would take them weeks where it
took me minutes.

One of the nice things about having image assets on layers is the flexibility it gives me in 
changing the scene. For example, if I had a tree on a separate layer, I could make the ninja 
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walk behind the tree just by changing the layer order and moving the tree layer above the 
ninja. It is that simple.


You are not limited to doing this with image assets in the background. You can do the same 
thing with photographs. For example, take this photograph right, a public domain photo I 
found on pixabay.com. I like to 
first apply a filter to make the 
photo look like an illustrated 
background. In this case, I am 
going to use a program called 
Artista Impresso Pro which 
basically takes a photo and 
makes it look like a painting. 
There are a lot of different 
presets you can try to get the 
look you like. It all comes down 
to a matter of preference in the 
style you choose.


Once you have made your 
selection, save the background 
image. Copy the painted image 
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and paste it into Photoshop onto a layer in the photograph document. I then like to turn back 
the opacity of the painted layer (top layer) to say 60-70% in order to get some of the detail 
from the photograph but still have the painted effect. 


Now, I have a background I can use to drag my ninja girl and place her with her shadow into 
this scene. Now instead of being in the vector asset forest, she is in this kind of painted forest 
(below)—and it is all photo based. 


Repeat the same exact silhouetting procedure with the front facing ninja photograph. Place it 
into this scene. Duplicate the ninja character layer several times, resizing each one to a 
smaller and smaller image. Then, you can create a series of images where you create the 
illusion that the ninja is farther off in the distance and appears to be walking closer to the front 
of the image because her position is changing and she is getting larger as she gets closer 
(see series below).
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Maybe you don’t want to do this process using photographs of miniatures. That is okay. You 
can do the same thing with clip art. 


Go to openclipart.org, a public domain site, search 
for a character you like and download the png 
(transparent) file. Open this already silhouetted file 
and going back to the original scene we built, drag 
the character onto the background and resize. 
Repeating the same steps we did before, we can 
position our character in the scene. Add all the 
characters you want in the same manner. Ideally, 
you want to find characters that have more than 
one pose, but even with static characters, you can 
reposition them to get multiple scenes.
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I want you to remember some things when it comes to illustrating your children’s book…


✦ Some of my students who have gone through my training courses on illustrating children’s
books have created some amazing illustrations. Many of these people never imagined they
could get a children’s book done before they learned these techniques and now they are
on Amazon selling books.

✦ These methods don’t require a huge amount of time or cost. The DO require planning and
some skill, but these are tasks anyone can learn and do easily.

✦ ANYONE can illustrate their own (or someone else’s) children’s book using miniatures.
Hopefully, from the examples I’ve shown here, you can see how powerful this can be,
especially if illustrations are the thing holding you up from getting your book done. Yes,
you will have to craft some sets and learn some photo editing skills, but these are things
you can pretty easily learn. The beauty is you are not limited if you don’t like a scene the
way you are when using traditional illustration.

There is an unlimited opportunity for creativity once you determine 
what you want the look and feel of your images to be so get started 
illustrating your own children’s books now. 
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Case Study 1: Compositing to Illustration 

The image for this case study was photographed in a simple setup using a $2 piece of 
cardboard from Walmart and a ring light. Ring lights are available for under $100 on Amazon, 
but you can use any kind of lighting. The robot is a Christmas ornament. The image far right is 
the resulting illustration. Using the technique demonstrated below, I was able to create a very 
cool illustration.


So let’s take a look at how I can create an image like this in a short period of time. I use 
Photoshop but you can use an image editor of your choice.


Demonstration: Christmas Ornament to Book Illustration 

1. The first thing I need to do after taking my photograph is isolate the robot from the
background. Photoshop has several ways to do this but I am going to use the Quick
Selection tool which averages colors. Using a little larger brush for the big areas, as I hold
my left mouse button down and drag across the blue background, it selects everything
close in appearance to what I am selecting, the blue. The more I drag, the more it selects.

Sometimes, as it is adding, it selects things I don’t want selected, i.e. parts that are not
the blue background. Once I have selected all the blue, I can reduce the size of my brush
and drag the tool over the areas I don’t want included in the blue selection—in this case,
the legs of the robot—while holding down the «option/alt» key. This will put the tool in
subtract mode and eliminate from the selection anything I brush over. Continue to reduce
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the size of your brush and in either addition or subtraction mode, remove the background 
and add back any mistaken selections of the robot until only all the blue background is 
selected. 


NOTE: Don’t get too picky about this selection being perfect. It really doesn’t need to be. 
Keep in mind that as compared to photographs, illustrations have significantly less detail 
regardless of the illustration method used. Once you start converting photos into an 
illustration form, less detail is better, so you want to reduce detail in going from a photo to 
an illustration. You can even use low resolution images and it doesn’t matter. You are 
converting the image into another form anyway so the detail will not play into it. 


2. We select the solid background because it is easiest for the tools to make an accurate
selection, but what I want is the robot so I need to invert the selection or select the
opposite of what I’ve selected. «Command/Control» «Shift» «I» or using the menu, Select
> Inverse; then «Command/Control» «C» to copy the selection > «Command/Control» «V»
to paste it onto a new layer; delete the background layer and you have just the robot.

3. Now, the problem is we have a very blue cast on the robot
(right) because of the blue cast from the paper. [Note: with
use of different lighting setups and some other techniques,
the cast effect could be greatly reduced if not eliminated,
so take time to do your green/blue screen set-ups and in
taking photos to improve your results!]

There are several methods in Photoshop for resolving this
problem and each can give a different result. The one we

are going to use is: Select > 
color range > sample blue 
from an area with a lot of 
blue like his arm. Turn 
fuzziness down so it is 
selecting primarily the blue 
cast; Create a new layer > 
sample a normal color you 
want from the robot > Edit > 
Fill > choose the foreground 
color you just selected to fill 
layer with this color; change 
the blend mode from 
“normal” to “color” which 
removes almost all of the 
blue cast (right); Select both 
layers and merge.


4. Now we need a scene to put the robot into. Go to
pixabay.com where all images are public domain and free
to use however you want. Search for “Planet.” Take note
that the top row of the search results are Shutterstock image links which are paid images.
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If you want a free image, scroll down on the 
page and look at your other options. Choose 
your image > download largest size > open 
image (right) in Photoshop.


5. This image size is 4000 x 3000 at 72 ppi. If
we are aiming for an 8 x 10 print (i.e. 300 ppi)
book, select inches in the drop down next to
width and height, turn on “resample” and
change image height to 8” (width will adjust
automatically if the width and height are
locked) and set resolution to 300 pixels per
inch. In this case, the width will be a little
wider than we want but that is okay because
we can go in and crop the image to get 8 x
10 or 2400 x 3000.

6. To create a composite of the two images:
Back on the robot tab, select the move tool,
choose the robot layer, click on robot and
drag finished robot to the tab for the
background scene and onto the canvas. Edit
> transform > scale to adjust the size of the
robot which in this case is too big and
position the robot where you want him in the
scene (right).

7. Add a little bit of a shadow to the robot so it
looks like he is standing there in the scene.
The easiest way is to right click on the layer
> choose blending options > choose drop
shadow, angle to 90, distance adjusted
down to get a slight shadow (image next
page).

8. You can now adjust the robot’s color. If he is
standing on Mars, he will probably have a
more reddish cast to him. The best way to
do this in Photoshop is «Command/Control»
«B» to bring up the Color Balance panel.
Move the sliders to tweak the colors in the shadows, mid-
tones and highlights until you are happy with the color.

9. Add a little more contrast. Space scenes are high contrast
and he isn’t so Image > Adjustments > Levels or «Command/
Control» «L» to open Levels; pull the shadows slider (circled)
to the right and adjust mid-tones slider (middle triangle) a little
to add contrast (image below).
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10. I’m happy with this so I want to right click on the layer > flatten image > File > Save as .jpg

11. Now I want to use a painting software to get an illustrated look for this image. I am going
to use Artista Impresso Pro from JixiPix Software. After launching Impresso Pro, open the
jpg and try out different presets and make adjustments to get a style I like for the
illustration effect I want. It all comes down to style preference at this point so experiment.
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There are many different adjustments you can 
control so you can tweak the preset (right) to 
get just the look you like. If you don’t like the 
auto painted edge it puts on the image, just 
select the canvas layer and turn that slider all 
the way to zero to get rid of it (circled).


I literally started with a Christmas ornament on 
a table and in only a few minutes I ended up 
with the image below. If I was to hire a 
traditional illustrator to create this illustration, 
it would take them a week and cost $300-
$500. The entire process of me taking the 
photo of the robot, silhouetting it in 
Photoshop, compositing the image into a 
photo background and applying a paint 
technique took me a total of 20 minutes and 
cost nothing but my time. If I didn’t like the style, in only a couple of 
minutes I could go back and change it to pen and ink or watercolor 
or whatever style I liked better. If I decided I didn’t like the position of 
the robot, I could just reposition it in the composite and apply the 
painting technique to the changed image. 
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Case Study 2: Creating Vector Art from Old Comics  

This process is completely different from what we’ve already done but equally as simple 
and effective once you’ve learned the techniques and know a little about the software 
needed. I think you will find it helpful when you are looking for source content to illustrate 
your own books.


1. Choose the Public Domain Comic Books button (right) on
www.comicbookplus.com. This will take you to a huge
selection of comics. Choose something that sounds
interesting to you. I’ll choose Space Mouse. The cover
actually looks pretty good but that is not typical. If you
invested in Drag & Drop Illustrator and need assets, pay
attention… Scroll through the pages of the comic book and
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you will see all the various 
images from the pages of 
the comic book.


2. Find an image you want to
use, zoom in your screen
and take a screen capture of
the image. I think you will
agree that this is not very
good. You can see the
printer dots, it is fuzzy and
low resolution. It doesn’t
matter.

3. Open the online site
www.vectormagic.com. It is
a very low cost option ($7.95 per month at the time of
this training) for creating vector images but if you use
professional software, Adobe Illustrator is the
industry standard. Once you’ve joined the site, find
the «Upload Image To Trace» button and click. Locate
the screen shot on your computer and select.
Something magical happens…the program is taking
this pixel-based image and tracing it, turning it into a
vector which will allow us to scale it to any size we want
without any loss of detail. The result isn’t perfect, but it
isn’t bad. You have the option to trace using low or high
detail. I’ve found when it comes to tracing photographs,
low detail is best, but when tracing comics, high detail
usually gives the best result (below). You can also set
custom colors. If you want to use a specific set of colors
in your book, you can do it with this program or with
Illustrator.
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4. Once you are happy with your trace, download the image. You have a few options: eps,
svg, pdf and png. I usually download the pdf because it is easy to work with in image
editing software like Photoshop. Open the downloaded pdf in Photoshop. Because this is
a vector, we can make this any size we want and it will retain the detail and sharpness.

5. We don’t need all of the talk bubbles if we are just working with an illustration. In
Photoshop, there are a couple of great ways to get rid of things like this. I like the Patch
tool. With it selected, I can just draw around something and drag the selection to another
area in the scene and it will pick up that area and average it into the selection. In this case,
I am going to select an area of the talk bubble and drag it to an area of the green
background. It doesn’t always get it perfect. You can do it several times to improve the
result, but in this case, it
really doesn’t matter. We
don’t need all of that sky
so I intend to crop it out.
You can also use the
Clone Stamp tool, set an
origin point and paint out
some of the discolored
area to replace it. The
Patch tool is unique to
Photoshop, but most
image editors have some
kind of clone tool. After
I’ve finished and cropped
the image, I get
something like the image
right.

6. Using Levels, I can brighten it and sharpen it up some. Double click the highlight
eyedropper in the Levels dialog box; make sure all the color values are set to 0; then
anywhere you click in the image with that eyedropper selected, the color value you click
on and anything lighter will change to white. Drag the sliders to darken up the colors and
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make adjustments to get the look you like. NOTE: this is a great technique for getting rid 
of yellowing on paper.


7. I could use this as is if I want to, but I don’t think it is all that pretty. I can save it as a jpg
and apply a different illustration software to it like the one we used in Case Study 1 or
something different. There are a lot of options, some expensive and some not. If you are a
PC user, you might try the free software FotoSketcher, fotosketcher.com. One application I
like is a Photoshop filter called Snap Art 4 from AlienSkin Software. This has a lot of preset
options that you can tweak settings for and even save changes as your own preset. I like
their watercolor and crayon presets as well as the colored pencil. Depending on the
application(s) I use and the settings I adjust will determine the look I get (samples below).
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Of course, you can mix and match elements from multiple images in a composite as I’ve 
shown before. It really doesn’t matter if one is a photo and one is a comic book illustration, 
if one is low resolution and one is high… When you apply an illustration technique, it will all 
blend together and match anyway. I just want to introduce you to the idea of what is 
possible. 


You have options! I’ve done complete illustration sets taking photos with my iPhone to 
prove I can do it. Some of my students have done amazing things with their point & shoot 
cameras. But you can also use public domain images and even old comic book images to 
create some really cool, new illustrations for your books with full control over the end 
result.


Let’s take a look at another comic book image so you can see how flexible this process can 
be…


Again, choose an image at 
comicbookplus.com, zoom 
in on it and do a screen 
capture. This image is 
horrible, and definitely low 
resolution, but we can work 
magic with it.


Upload the image to Vector 
Magic > trace it using high 
detail tracing. The tracing 
process will remove all this 
blocky, pixelated, fuzzy junk 
in the image and you could 
blow it up to billboard size if 
you wanted. So you know, I 
have never worked with this 
image before. I picked it at 
random here live in the 
training so I have no idea 
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how it is going to turn out. In the end, it is okay, but…


A nice thing about this software is that you can have the 
program draw from an unlimited color palette, basically drawn 
from the comic itself or you can do custom colors. Process 
the image as artwork; it will go into the image and analyze the 
colors in the image offering color sets as a suggestion. Say 
you want to go with six colors. You can see where it pulled the 
six colors (circled) from the image. Click on any color and you 
can move around in the image to select any other variant or 
color for that color and it will replace it in the color palette. 
Now when you re-trace the image as artwork using the 
custom color palette, you will get a cool result. Download as a 
pdf and open in Photoshop, scaling to whatever resolution 
you want.


Paint out the type and any 
extra things you don’t want, 
make any changes you want 
and save the image. Use a 
paint program to turn this into 
a different style of illustration. 
In a relatively short period of 
time, you can go from 
something useless to a clean 
and unique-looking 
illustration.


You can literally go back to 
the comic book and do 
screen captures of several 

images from a page using the text in the comic as text for your story with newly colored 
images. That is a powerful tool. 


These are all methods I teach in my course on using Adobe Illustrator. It gives you more 
flexibility than this online program but of course, the price and learning curve is different, too.
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Case Study 3a: Pencil Drawing 

For this case study, I am going to convert the photo below into a pencil drawing. I will be 
using Photoshop but you can use the image editor of your choice. The process works 
exactly the same using the online program, Gimp Shop.


1. Open the image of the canon in Photoshop and duplicate the layer. I want to convert this
copy into a grayscale image: Image > Adjustments > Desaturate > duplicate the
desaturated layer. You should now have an original background layer in color and two
layers of the same image in grayscale.

2. Invert the top layer grayscale image: keyboard command is «Command/Control» «I» or
using the menus Image > Adjustments > Invert. You will see the image below:
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3. The blending mode on the top layer will be “Normal,” the
default in Photoshop. We want to change the blending mode
to “Color Dodge.” Note: in Gimpshop, this is just “dodge.”
When you do this, the image will basically disappear or turn
white or white with only a few dark marks.

4. In the menus: Filter > Blur > Gaussian Blur and you will get
the makings of a pretty cool pencil drawing (below) with just
a simple filtering trick. As I change the radius of the blur
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downward, the lines thin and there is more detail and fineness in the lines. As I drag the 
slider higher and higher, it brings in more shadowing. It is your prerogative. You can also 
do two variations, one thin and one thicker and sandwich them together. For this, I am 
going with a setting of around 5.2 > «OK»


5. Merge the two layers: highlight the two desaturated layers > right mouse click > merge
layers. With the layers merged, I can use Levels to darken it or whatever I want to do:
«Command/Control» «L» to bring up Levels and move sliders to get the look I like for the
line drawing (below).

6. I want to add a filtering option to this drawing: Duplicate the merged layer > Filter > Oil
Paint (or Filter > Stylize > Oil Paint in the latest version of Photoshop). With the oil paint
filter, I can easily stylize this illustration. As I move the Stylization and Cleanliness sliders
down, the image goes more and more toward the original line art. As I move them to the
right, the filter begins to elongate the strokes and stylize them more to look sleek and
elegant. You can control how much distortion occurs in the image. You can also change
the lighting. As you increase shine, it shows brush strokes. Moving the scale slider up
makes those brush strokes larger. In this case, I don’t want brush strokes to show
because I am trying to create a line drawing, so I am going to keep the shine turned all the
way down to 0.  NOTE: This is a Photoshop-exclusive technique.

7. ALTERNATE EFFECT: I can also combine these images together. Drag the original
illustration to the top layer above the oil paint layer. With the original illustration layer
selected, change the blend mode to “Multiply” and combine it with the layer underneath.
Adjust the opacity to get a combined image that suits you.
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8. ALTERNATE EFFECT: let’s say we want this to be a simplified color illustration. As I
mentioned in the training, the secret to illustrations is to simplify or reduce detail.
Illustrations are simple, not detailed like a photograph. Because photographs record so
much detail, you need to simplify the details when working with photographs. We are
using filters to do that: Turn off the two illustrated layers and then make a copy of the
original color image
layer. Now, Filter >
Blur > Gaussian Blur
to put this duplicate
out of focus, around
10 pixels in this
case > Filter Gallery
> Palette Knife
(image right). This
looks cool by itself,
but when we turn on
the oil paint layer we
just made and set
the blend mode to
“Multiply,” we get an
image with some very cool painting features (below).
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9. ALTERNATE EFFECT: there is another effect we can try. Remember, this is all about layer
interaction. Right now, I have the oil paint layer set to “Multiply” and that is exactly what it
is doing; but if I set it to Luminosity instead of Multiply, the line drawing will take on the
attributes of the layer below it so I get this image:
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10. This image is a little light, and maybe I want it to be this way. But if I want it darker, I can
add a Levels Adjustment Layer (the little circle at the bottom of the layers panel that is half
black and half white) and darken the image up to look like this:

I downloaded a photo for a project. Let’s see how it looks applying the same process as 
above: duplicate original layer > desaturate > duplicate desaturated layer > Invert layer > 
blend mode Color Dodge > Filter > Blur > Gaussian Blur > merge two desaturated layers > 
Levels > adjust to bring out lines and darken it slightly > change blend mode to Luminosity to 
get a color drawing > add Levels Adjustment layer and intensify color. If you want to, add oil 
paint filter to the illustration layer to get a cool, stylized effect (below). 
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Case Study 3b: Oil Paint 

Now let’s do something 
different. I have the same 
canon photograph but I’ve 
stylized it by applying a 
couple of filters (right).


This time, instead of 
applying a line drawing to 
the image, I want to go 
straight to oil paint filter 
and apply it directly to the 
photo: with this layer 
selected: Filter > Oil Paint 
(or Filter > Stylize > Oil 
Paint depending on your 
version of Photoshop. As I 
push Stylization and 
Cleanliness up, add a tiny 
bit of shine to get a little brushstroke and a little scale for the brush, my photo starts to really 
take on the characteristics of an oil painting, a very stylized oil painting, in about two minutes.


These are just two of dozens of techniques and filters I teach to create illustrated art from 
photographs.
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Case Study 4a: Color Pencil Drawing 

This is a very interesting technique that you can do in any decent image editing program.


1. Layer 1: This is a low resolution image. I am going to make this image bigger, scaling it up
to maybe 1400 px wide. One of the nice things about these illustration techniques is that
they usually work better with low resolution images. Where you normally need high
resolution, in many cases for illustrating it is better to start off with low resolution images
and then scale them up later after the illustration technique is complete.

2. Duplicate the layer [layer 2]; on layer 2, Image > Adjustments > Desaturate

3. Copy desaturated layer [layer 3] (you will now have a color layer and two identical black
and white layers.). With layer 3 selected, Image > Adjustments > Invert or «Command/
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Control» «I» to make everything that is white to black and vice versa, i.e. create a negative 
of the image.


4. Change blend mode of layer
3, to Color Dodge and it
will go white or nearly
white > Filter > Blur >
Gaussian Blur, adjust
radius to lighten or darken
the image. It looks like a
pencil sketch. The radius
will change based on the
resolution of your image.
There is no “magic”
number that is right so
you just have to
experiment with the
image you are using.

5. Highlight (or select) the
top two layers and drag them to the new layer icon to make a copy of the layers > right
click on the two copied layers and choose “Merge Layers.” [Layer 4]

6. Now that the illustration layers are merged into one, I can
do things like making it darker: with Layer 4 selected,
«Command/Control» «L» to bring up Levels panel > drag
shadows (far left) slider to the right to darken image. You
can adjust the details that are showing by dragging each
of the sliders. Now you have your down-and-dirty black
and white illustration from a photo (below):
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7. Now, click on the background color layer, Layer 1 and make a copy of it [Layer 5]. Drag
Layer 5 to the top layer, on top of the image we made above > change the layer blend
mode from Normal to Color to colorize the grayscale areas (below).

8. Duplicate Layers 4 and 5 > merge copied layers [Layer 6] > bring up levels again to darken
the color and you have a color pencil drawing (below).
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9. ALTERNATE EFFECT: let’s go on and have some more fun… Turn off Layer 6; select
Layer 5, the color version that is the original copy of the color background > change layer
blend mode back to Normal > Filter > Blur > Gaussian Blur to throw this out of focus,
around radius of 7-10 (NOTE: this depends on the image so there is no “right” number).
Turn Layer 6 back on and set blend mode to Multiply.

10. ALTERNATE EFFECT: You may or may not like that style. There is more we can do… Turn
off Layer 6 and with Layer 5 selected: Filter > Filter Gallery > try some of the filters like
Underpainting or Palette Knife to remove some of the detail that is in a photograph but not
normally in an illustration. Using Palette Knife and adjusting the stroke size, amount of
detail, softness, etc. Turn Layer 6 back on and we get this sort of watercolor effect (top
image next page).

11. ALTERNATE EFFECT: Change Layer 6 Blending mode back to Normal > Filter > Oil Paint,
adjust Stylization and Cleanliness to get some smoothing and elongation of lines to suit
you (you don’t have to have a really strong effect) > change blend mode to Multiply and
now you get a beautiful smoothed out illustration from mixing and matching effects
(bottom image on next page).

We could use ANY of these versions for illustrating a children’s book. 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Tony Laidig

Case Study 4b: Convert and Stylize Low Rez Image 

Let’s look at another variation on the same 
things I’ve taught you here using this image I 
shot of a turtle. This is a low resolution 
image, 960 px wide x 640 px high at 72 ppi, 
below Kindle’s recommended minimum 
resolution for images. If I want to create an 
image of this for print, it needs to be 300 
ppi. I am going to make it into an oil painting 
and up-rez it to get a print-quality version.


1. On the image layer, Filter > Oil Paint,
using default settings or adjust the
Stylization, Cleanliness, Shine, Scale, etc. to get a look that appeals to you (image below).
I’ve turned Cleanliness up and Stylization down. Experimenting really pays off in this
process.
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2. Image > Image Size >
leave width and height
alone but change
resolution to 300 and
check “Resample.” So, we
are going from 960 px up
to 4000 px. You can
guarantee it is going to
look pixelated (right). If we
were doing this in print
form, it wouldn’t be
acceptable.

3. Go back to Filter > Oil
Paint and adjust the
settings slightly. Again,
these adjustments are not
hard and fast. You need to
experiment here. What
happens is we get a
sharpened image (below)
instead of the blurry, pixelated image above. This will work really well as an illustration and
it actually looks very stylized. All this from a crappy, low-resolution image.
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Case Study 5a: Pencil Drawing to Watercolor 

This image is not high resolution, only 960 wide at 72 ppi. If I were producing this image for 
a Kindle book I would probably leave this width as is for now and then reduce it later. If I was 
going to use it in a print book, it would need to be bigger than it currently is. One of the great 
things about this particular method is that I could double the size of this up to 1800-1900 
pixels and it wouldn’t matter. In fact, it would probably enhance the effect. Low resolution 
images actually work a little better in these illustration techniques. So, for the sake of 
demonstration, I am going to leave it as is.


Our goal is to take this photograph of a covered bridge and turn it into a pencil drawing.
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1. Duplicate the background layer [layer 1] to create a new layer [layer 2]; on Layer 2, Image
> Adjustments > Desaturate (below left)

2. Copy desaturated layer [layer 3]. We now need to make a negative of this layer, or invert it
to make everything that is white to black and vice versa. With layer 3 selected, Image >
Adjustments > Invert or «Command/Control» «I» (below right)

3. Change blend mode (circled below left) of layer 3 from Normal to Color Dodge and it will
go white or nearly white > Filter >
Blur > Gaussian Blur. As you
adjust move the radius slider in the
Gaussian Blur filter (circled far
right), it lightens or darkens the
image. I try to target a number
around 1-2 pixels, but the radius
will depend on the resolution of
your image. You have to
experiment. The image is a little
light, and it may turn
out to be very light
when you adjust the
blur radius to get the
line width you want,
but we can fix it. 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4. Highlight (or select) the top two layers (layers 2 and 3) and drag them to the new layer icon
to make a copy of the layers (NOTE: we are making a copy just so we have the original
layers in case we need them but you don’t have to make a copy), move the layers to the
bottom of the stack for safe keeping and click the eyeball next to each of these layers to
turn off the layer > right click on the two copied layers and choose “Merge Layers.” [Layer
4]. You will now just have the outline image on top of the layer stack.

5. Now that the illustration layers are merged into one, I
can make this image darker: with Layer 4 selected,
«Command/Control» «L» to bring up Levels panel. In
the Levels panel (right), you have three little triangles
corresponding to shadows (left side), mid-tones and
highlights (right side) > drag shadows (far left) slider
to the right to darken image. You want to find a
happy balance between getting the right amount of
darkening without too much detail. It is at least in
some part personal preference. You can adjust the
details that are showing by dragging each of the
sliders. Now you have your down-and-dirty black
and white pencil illustration from a photo (below):
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6. If you zoom the image up to 200%,
you can see it is a little blocky. This
might work fine for you, but we can
also take this a little farther to
change that look if you want it
smoothed out. Let’s say we want to
turn this into an accented watercolor
drawing…Click on the background
color layer (Layer 1) and make a copy
of it [Layer 5]. Turn off Layer 4, the
merged layer. With Layer 5 selected:
Filter > Blur > Gaussian Blur to throw
this out of focus. In this case, blurrier
is better, around radius of 5-6
(NOTE: this depends on the image
so there is no “right” number).

7. With the Layer 5 selected: Filter >
Filter Gallery > Palette Knife to
remove some of the detail that is in a photograph but not normally in an illustration. I am
generally using a Stroke size of 25, Stroke Detail of 3 And Softness of 0. It takes the blurry
edges of the photograph and sharpens them but makes them a lot more blocky, not unlike
a watercolor painting.
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8. We’ve definitely lost a lot of detail, but turn Layer 4, the merged pencil drawing, back on
and change the blend mode of Layer 4 from Normal to Multiply. Now, we have back the
lines that give the image some detail and the combination of the two images gives us a
cool effect.

9. You can control how much of
the line drawing you want to
shine through by adjusting
the opacity of that layer.
Lower opacity means less of
the line drawing shows.

10. If you want a more intense
color in the image, you can
adjust it. With the color layer,
Layer 5, selected:
«Command/Control» «U» to
bring up the Hue/Saturation
panel. Drag the saturation
slider up and you get a more
intense color (right).
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Case Study 5b: Oil Painting  

I want to show you how to make this look more like an oil painting. The oil filter is a relatively 
new effect in Photoshop—and it is a Photoshop specific filter so you will not have it in Gimp—
but it does some very interesting things. You can have a lot of fun with it, especially with line 
drawings


1. Duplicate the top layer, Layer 4, to create Layer 6 so we have a new one to work with for
this technique. Turn the line drawing in Layer 6 back to Normal blend mode, 100%
opacity. Turn off layer 4.

2. With the new Layer 6 selected: Filter > Oil Paint or in the latest versions of Photoshop,
Filter > Stylize > Oil Paint. You can see below that it looks a little funky because it is made
to follow the lines like an oil painting. For what we want it to do in this case, turn the shine
—which basically controls the texture—to 0. As you make adjustments to Stylization and

Cleanliness, you get totally different looks. High stylization with low cleanliness is a much 
different appearance than the opposite. You can experiment and play around with these 
two sliders to get a look you like. In this case, I am going to set Stylization at 3.66 and 
Cleanliness at 1.9. I get this beautiful, fluid and smooth image (below):
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3. One artifact of this filter is a light tint it
adds into the white areas of the image.
In other words, the white is no longer
true white. I like to reset this value to
white. It is easiest to do with Levels:
«Command/Control» «L» to open levels.
In the Levels Panel, you will see three
little eyedroppers (circled). The one on
the far right is the highlights eyedropper
which lets you set a white level. Choose
this eyedropper and on the image, click
on any area of the image that is “white.”
You will now see that it instantly
brightens and whitens the image
because it changes that grayish tint to
white. This eyedropper basically tells
Photoshop to set any color equal to or
lighter than the color value you click on
to be white so be careful to click on an
area you want to be white. You can also drag the shadows slider (far left triangle) to the
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right to darken up 
the blacks in your 
image. You will get 
this:


4. Make sure layer 6
is on top and then
apply this layer to
the blocky color
layer, Layer 5, by
changing the blend
mode of Layer 6 to
“Multiply.” You get
an even more
stylized look
(below).
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Case Study 5c: Watercolor 

In the Advanced course of Easy Book Illustration, I added some steps to the Line Drawing to 
take it up another notch, to make it look more like a watercolor, an effect I like working with. It 
is an advanced course for a reason so these steps are a little more advanced, but I think you 
will like seeing the process. 


This originated from me reading Winnie the Pooh books to my granddaughter. I noticed some 
of those books have a very stylized watercolor background and I wanted to see if I could re-
create that with photographs. I set out to try to mimic the watercolor effect in those books 
which were done by traditional artists. 


This technique builds on what I taught here but uses Adobe Illustrator and some other plug-in 
filters that work with Photoshop.


1. With our original merged line drawing, Layer 4 highlighted: «Command/Control» «A» to
Select All > «Command/Control» «C» to copy it.

2. Open Adobe Illustrator. One of the nice things about working with the Adobe products is
how well they all play together because Adobe made them that way. In Illustrator, create a
New document with whatever default settings it has and «Command/Control» «V» to
paste.

3. With the line drawing now in an Illustrator document, find the «image trace» button in the
top menu bar and click on it. You will get a not very sexy-looking image, but you will now

see the drop down menu for “Preset.” Next to that is the little icon for the image trace 
panel. Click on the icon to open the panel. Now, you will see “Threshold.” Essentially what 
we are doing is converting the illustration we made in 

Photoshop into a vector-based drawing. What I’ve found 
works best in this case is turning the Threshold up to 
around 220 or so. Again, this is subjective. It is a matter 
of what looks good aesthetically and that will change 
based on the image and your personal preferences. 
Again, select all > copy > go back to Photoshop and 
paste this image (Layer 7). When you paste, Photoshop 
will ask if you want to paste as a Smart Object, Pixels, 
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Path or Shape Layer. You want to choose “pixels.” Once it places the image into your 
workspace, there will be a big “X” through the image. That is just Photoshop’s way of 
asking if you’re sure you want to do this. Just hit the «Enter» key.


You can see there is a lot less detail. You may be thinking, “Why take this step?” Let’s 
see…


4. We no longer need Layer 4 so you can
just turn it off. Select Layer 5, the
blurry, palette knife color layer and
duplicate the layer (Layer 8) so we
have a new copy to work with. Move
the layer to make sure it is directly
above Layer 7, the new layer with the
Illustrator image layer. Change the
blend mode of Layer 8 from Normal to
Screen. Essentially, this takes the
colors of the color layer and colorizes
the lines of the illustration layer
beneath it.

5. Select both layers 7 and 8 > right click and choose Merge Layers. Change the name of
this layer (by double-clicking on the layer name) to something like “color illustrator merge.”
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NOTE: you can start to see why it is important that you learn to name your layers each 
time you create one and give the layers meaningful names so you know what you are 
working with. When you merge a layer, Photoshop automatically names that layer the 
same as the top layer being merged. With a lot of merging, this could get quite confusing.


6. Change the blending mode of this new layer to Multiply. We are now using colors instead
of black because we colored the black lines of the line drawing. Turn the opacity down
and it will add subtle detail that is not in the previous version.

7. I want to bring the whole watercolor feel home including paper texture. There are a
number of ways to do this. The method here is to use a Photoshop plugin called SnapArt
from Alien Skin. Once you have properly installed the software, it will automatically appear
under the Filters menu dropdown in Photoshop. You get a number of different modules in
the plugin to simulate various artistic treatments and techniques. I demonstrate several of
these in the Easy Book Illustration courses. For this one, select the color layer we have >
Filter > Alien Skin > Snap Art 3 (NOTE: the current version is now Snap Art 4) and under
watercolor settings, choose “Landscape-More Detail.” You have the flexibility to change a
lot of settings for any of the presets in the software and tweak to get the look you want,
but for this particular illustration, I am just going to use the default preset. What this does
is smooth out the hard edges and introduce a light paper texture like a regular watercolor
would have. You can see the before and after images below. NOTE: One of the nice things
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AFTER

BEFORE
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about Snap Art is that it automatically makes a new layer for you. You will need to be 
careful when using other plugins because most don’t do this. Make a copy of the layer 
you are working on before you use a 3rd party filter to make sure you can get back to your 
original if you need it.


8. If I take this new watercolor layer and turn back on the illustration layer created from the
Illustrator layer, it introduces more detail into the image. I can even go back and turn on
the oil paint layer we created earlier and introduce even more detail. If the detail is too
much for you, remember, you can tone it down by lowering the opacity of that layer.

BEFORE

AFTER

Watercolor layer 
with illustrator 
merge layer above 
it turned on at 
about 50% opacity 

Watercolor layer 
with illustrator 
merge layer turned 
on at about 50% 
opacity PLUS oil 
paint layer on top 
turned on at about 
50% opacity
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Case Study 6: Photo Whimsical Illustrations  

In this case study, I am going to deconstruct the Whimsical Illustration Style of New York 
Times best-selling author/illustrator, Nancy Tillman. Because her style is hand-produced, 
obviously there is a certain level that we can’t achieve using digital, but I think we are getting 
pretty close. Tillman’s illustrations are very painterly and photo-realistic but she adds some 
whimsical “fairy dust” elements, sometimes with musical notes or stars, etc. There are 
usually animals and they are most often juxtaposed against backgrounds where you would 
not normally see those animals.


We are going to create an image 
like the one right. We are 
primarily going to use Photoshop 
but I am also going to introduce 
you to SnapArt 3.


Because this type of illustration 
includes a number of different 
elements that are not “normal” to 
find together, it requires that 
multiple different photos are used 
to extract elements and then put 
them together into the image.
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This is the base background photo. All of the photos I will use in this case study were 
purchased and dowloaded from photos.com. I could have taken some of the photos myself, 
but sometimes I find that when I am working a composite image, it is just easier to pay a few 
bucks and download an image. This is especially true when I want objects, animals, people, 
etc. 


I have a very specific set of criteria I use for choosing these images. As much as possible, I 
want those images to have a white background like these. It makes it easy to 
silhouette. It isn’t always 
possible to get a white 
background, but it is 
always my first choice 
when I can get it.
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PART 1: SILHOUETTE 

The first thing we need to do is silhouette the object images or remove them from their 
backgrounds so they can be placed into the background scene. I am going to use a couple of 
methods in Photoshop to do that. 


1. Starting with the boy, I will use the magic wand tool and set the tolerance to 20: click on
all the white areas to select the white > select the inverse of the white (i.e. the boy) by
using the keyboard command «Command/control» «I» > «Command/control» «C» to copy
> go to the background image tab «Command/control» «V» to paste. I am not going to
scale anything right now. I want to get all the components in one document and then I will
make those adjustments.

2. Continue using the exact same method on every image with a
white background. On some images like the giraffe, the magic
wand may pick up some of the whiter areas in the object (image
right). If this happens, lower the tolerance and re-select the
white area. It won’t be as tight, but it is better than having it
select part of the animal. If it is still selecting something you
don’t want it to, choose one of the lasso tools, hold down the
«Option/Alt» key to subtract and lasso over those areas to
remove them from the selection. NOTE: Remember that
illustrations have a lot less detail than photographs and we are
reducing detail so if your image isn’t perfect, it doesn’t matter.

3. With the polar bear, the image doesn’t have a white
background and there is no way the magic wand tool is
going to work to remove the bear from the background.
There is a tool in later versions of Photoshop called the
Quick Selection tool. This uses a combination of edge
detection and pixel-matching to select an area of an image
that is related. When I click and drag my mouse on the
bear, the tool selects just the bear for the most part. In
some cases, the tool will pick up areas you don’t want
because they are so close in color to a nearby area of the
item you are selecting. In this case, I picked up a little
selection of the wall. By holding down the «Option/Alt» key
while dragging back over the wall area that was picked up,
the tool will remove material from the selection. It may at
times remove too much, like removing a little of the bear along with the bit of wall. Release
the «Option/Alt» key and mouse over the bear area again. Each time you do this, the tool
“learns” more about the specific area you want and makes an increasingly better
selection. Remember, in this case, close is close enough. The selection doesn’t have to be
perfect. When the selection is made, copy and paste into the background scene.

4. Once all the silhouettes are completed and have been placed into the background
document, we want to get rid of the little halo effect (image below) that often happens

Illustration Kickstart

93



when you are silhouetting. I can use the Defringe tool: Layer > Matting > Defringe on each 
of the object layers. This matches pixels at the number of pixels in you specify and 
removes that much from the image. I am going to use one pixel and just get rid of some of 
the white edge left over from removing the background.


5. Sometimes, like with the giraffe, you are going to
end up with silhouettes that are not super clean
(right) with little jagged edges, etc. There are a
couple of ways to deal with that because Defringe
won’t take care of that. You can go in with the
eraser tool and just clean up these edges or you
can select just the giraffe by holding down the
«Command/Control» key while clicking on the layer
icon (the image not the layer name) > Select >
Modify > Smooth about 2 pixels > Select > Modify
> Contract by 2 pixels > inverse the selection by
«Command/Control» «Shift» «I» > «Delete». Now
all the white area around the neck is gone.

PART 2: CREATE THE SCENE 
1. Starting with the boy, scale him down by choosing

the move tool to bring up the handles around the
image or Edit > Transform > Scale and drag
resulting image handles to resize the image. Scale
the image to about what you think he will be in the final image, but not too small. You can
always scale him down more later, but you will lose quality by trying to scale up later so be
aware of that.

2. Continue scaling down each object layer on top of the scene. If you turn off all the object
layers and then turn each one on as you are working on it, it will make it easier for you to
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isolate the layer you are scaling. You might want to scale the largest character in your final 
image first so you can scale the other images to be relative. Remember that objects closer 
to the front are going to be larger than objects in the back of the scene. I am going to use 
this “forced perspective” to my advantage and make it appear as if certain objects are 
farther back in the distance than others. For example, I am making the zebra extra small 
so that when I position him, he looks like he is off in the distance.


3. As you are placing the objects in your scene, if an object is facing the wrong direction, you
can right mouse click and choose to flip an object (or find the menu command in Edit >
Transform) to make it face the direction you want as I have done with the giraffe. You can
move the objects around and reposition them however you want in building your scene.

PART 3: ADD WHIMSY 
Now, we get to have fun. We are creating a whimsical illustration so we don’t need everything 
to look realistic.


1. The first thing I want to do is darken the elephant because tonally, he doesn’t match the
rest of the image: «Command/Control» «L» to bring up the Levels panel and drag the
shadow slider to the right; do the same with shadows, mid-tones and/or highlight sliders
for each of the object layers to get the tonal quality in the objects that you want.
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2. Let’s change colors. What if in our whimsical illustration we don’t want a gray elephant?
Well, it doesn’t have to be. We can change it to whatever we want. Bring up the Hue and
Saturation panel with the keyboard command «Command/Control» «U». Either drag the
hue slider or choose the checkbox for Colorize and drag the hue slider. Each will affect the
pixels a little differently. Choose other layers and bring up the same Hue/Saturation panel
to make changes to those as well.
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3. We can do other things like adding shadows to make the characters more realistic in the
scene. One thing we have to do is blend their feet into the grass so it doesn’t look like
they are floating. That is pretty easy to do:
At the bottom right of the Layers panel,
next to the fx is a rectangle with a circle in
it. This is a layer mask. Select an object
layer and click on the layer mask icon to
add a mask to that layer > choose a paintbrush, one of the speckled or grass
blade ones > making sure to have black in the foreground, just dab the brush
around the feet of whichever character is on the layer you have selected.
Repeat the same process with each of the object layers to make them look like
they are standing down in the grass (below). This doesn’t have to be super
perfect because when we do the illustration techniques, it won’t matter anyway.

PART 4: ILLUSTRATION TECHNIQUES  
1. Select all the layers: Select one and with the «Shift» key down, continue selecting each of

the layers until all are selected > Drag all the layers down to the new layer icon (next to the
trash can in the layers panel) to duplicate all the layers. We are creating a copy of all the
layers so we have the originals to get back to if necessary. With all the duplicated layers
still selected, right mouse click and choose “Merge Layers.” Now, I have a single image of
all layers self-contained. Turn off all the original layers or put them into a group (file folder
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icon) and turn the group off. NOTE: if you are a more advance Photoshop user, you may 
work with all these original layers as smart objects. 


2. With the merged layer selected, Filter > Filter Gallery and experiment with some of the
filters in Photoshop. I like Underpainting with adjustments to brush size, texture, etc. The
idea is to reduce detail. Palette Knife is another filter I use sometimes. Dry brush is
another decent filter for this purpose. If you experiment, you can see that there are a lot of
different looks you can get with these various filters and adjustments to their slider
controls. Some filters work better than others depending on the image and kind of look
you are trying for. Play with it to develop your own style.

3. ALTERNATE EFFECT: Another option in Photoshop is the Oil Paint filter, Filter > Oil Paint
in earlier CC versions and Filter > Stylize > Oil Paint in the newest versions of Photoshop.
This introduces swirls and textures. You can control the texture by increasing and
decreasing the Shine and the amount of swirl that happens by adjusting Stylization and
Cleanliness (below). You can always make copies of the merged layer and experiment with
different looks on each layer. You can even mix and match the layers by adjusting the
opacity on layers so that effects from lower layers show through. It is all a part of
developing your own style of illustration.

4. I am going to use an oil paint filter on my illustration. Once the filter is applied, you can
brighten up the hue or make it more brilliant looking by increasing the saturation with

Illustration Kickstart

98



«Command/Control» «U». You can adjust levels, «Command/Control» «L» to maybe 
darken it up a little (below). 
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ALTERNATE EFFECT: I also want to take a look at a set of plugins for Photoshop called Snap 
Art. It is with this set of filters that we are able to get closer to Nancy Tillman’s look. Snap Art 
is a paid plugin from Alien Skin. I have a preset I’ve created that converts the image into a 
painting but I am varying the color stroke, photorealism, stroke size, etc. (below). You have a 
lot of control over these variables in Snap Art so you can get a look that is artistic and unique 
to you. One nice thing about Snap Art is that it makes a layer copy for you when you apply 
the filter so you still have your original if you want to try something different.


Just as I did before, I can adjust the hue/saturation or bring up Levels to darken/lighten the 
image, etc.
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PART 5: KICK UP THE WHIMSY 

One of the things that makes Nancy Tillman’s work unique is the addition of whimsical 
elements like stars, musical notes, hearts, etc. In Photoshop, it is a pretty easy process for us 
to do that.


1. Create a new layer. Using the eyedropper tool, take a color sample from the image. I am
going to use the peach color from the sky.

2. Preload brushes (there are a lot of them in Photoshop) and choose one. I am going to
choose a butterfly brush and increase the size of the brush.  With a brush chosen, click on
the brush presets (circled below) in the top toolbar. This will bring up the brush presets
panel that gives you a lot of great controls over the brushes. One of those controls is

“Spacing.” If I increase the spacing from the default 
settings, the butterflies space out so you can 
actually see butterflies. We also have the ability to 
scatter the butterflies. Choose “Scatter” and control 
how much they scatter by the count, based on 
percentage (how spread out they are), etc. Another 
option is “Shape Dynamics” which tapers the front 
and back edge. If you are working with a pen tablet, 
you can control a lot of this with pressure of the 
pen. I am just using a mouse so with shape 
dynamics turned on, I get a more fluid look. The last 
element I want to add is “Color Dynamics”. With 
this selected, make sure the hue jitter is turned up 
high and as it paints the butterflies, it shifts the 
color of them based on my foreground color (right). 
Adjust the hue jitter down to have the color change 
less. With these settings adjusted, I can literally 
paint the butterflies into my scene (image below). I 
can make adjustments to my brush size and presets 
as I paint butterflies so that I have some small and 
some larger, smaller ones in the background and 
larger ones in the foreground, a different scatter in 
different parts of the image, etc. 


3. Because the butterflies were painted on their own
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4. When finished with your design, save the Photoshop file. Then, Layer > Flatten image >
File > Save As a .jpg for a book or .tif image for a print book.

layer, we can turn them on and off, apply effects to them or add shadows. Right click on 
the butterfly layer and choose “Blending Options” > Drop Shadow. Adjust the angle, size, 
distance, etc. to add another dimension to the butterflies. I can also add a filter to the 
butterflies, change the opacity of the layer, and other things because it is on its own layer.
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Bonus Case Study: Illustration Using Pastello Pro 

I picked up these little steampunk dinosaurs at a local comic con and am planning to do a 
story series around these guys. I took this photo in my back yard while lying on the ground. 
I want to take you through the process of turning this into an illustration using some new 
software called Pastello Pro by JixiPix.
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INTRODUCTION TO PASTELLO 

Launch Pastello > File > Get Photo to open image from your computer. Pastello has a lot of 
built-in presets so you can get a lot of different looks based upon what you want to 
accomplish with your illustration style. There are a series of presets for each of the following 
styles: chalk, charcoal, colored pencil, conte, crayon, Da Vinci, Pastel, Pencil, and your own 

saved presets. There is any number of combinations you can come up with and you can 
select presets and edit them to create your own version. The options are nearly endless.


Selecting the Da Vinci style, I want to show you several of the 
presets in just this particular style (below) so you can see some of 
the variety in these presets. 


On the right side of the 
screen (image far right), you 
can see all of the layers that 
make up a particular preset 
and the variables you can 
change. Each layer in a 
preset can be edited.


When you are working with 
photos and turning them into 
illustrations, it comes down 
to what your desired end 
result is, what kind of look 
and feel you want to 
accomplish with your finished 
illustration. I usually combine 
multiple versions to get the 
end result I am after. You 
don’t have to, but it is 
certainly possible.


With the paper, you can add 
painted edges or turn the 
edge stroke to zero to 
eliminate the edge altogether.
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ILLUSTRATION TECHNIQUE 

1. Choosing one of the presets > adjust Color Enhance slider up if you want to make the
color stronger, reduce stroke size and variation to increase detail on a layer, etc. Each of
these changes affect only the layer you are working on and you can make adjustments to
any and all of the layers. My goal is to enhance the dinosaurs and make them stand out
more. I am going to add other techniques to further enhance them, but I want to make
them stand out in Pastello. Be aware, some of the layers are only focused on highlights
while others control only shadows. Pay attention to this because it can affect the final
outcome.

2. Once you have made the
changes you want, File >
Save Photo. It will take a
little time to save in this
program because it has to
render the final image first.
Once rendered, you will
get the dialog box to name
your file for saving. Once
you have saved this, you
can switch to another
medium if you want, color
pencil (below), for
instance, to create
something else entirely
different. I just like to
experiment with all the
presets to find what I like and then add enhancements to the layers making up that preset.
Enhancements are often subtle, but they are still there.
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3. If desired, you can add an artistic edge to any image. On the
Paper layer, click on the box next to “Artistic Edges” to open
the menu of edge options and then adjust the stroke size of
whichever one you choose.

4. Now that I’ve saved these two versions, I want to look at another program called Akvis
Draw. This is a great program that gives you the ability to create line drawings of all types.
The presets are pretty powerful though I have modified some to make my own. It looks
like someone sketched it freehand with a pencil. Save this.
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5. I want now to bring all the illustrations I just created into Photoshop. Select each individual
file in Photoshop > select all > copy > paste as a layer into a single document. I want to
use an eraser tool and clean up some of the extra lines on the Akvis Draw file before
copying and pasting into Photoshop.

6. Once I have each of these in a layer stack in a single file, I can begin to adjust the way the
layers interact with each other. I want to create a composite of all three images. I have the
Da Vinci on the bottom, the colored pencil in the middle and the line drawing on top.
Turning off the top layer for now, I want to leave the color pencil blend mode as Normal
but change the opacity of the layer to around 30%. I want it to affect the Da Vinci layer but
not in an overwhelming way. You can try different blend modes if you want. For me, it
doesn’t give me the effect I am after for this illustration.

7. Turn on the drawing layer > change blend mode from Normal to Multiply. At 100% opacity,
the effect is too strong (below) for me. I want for it to just provide a little more detail in a
subtle way. So, I want to turn the opacity down to around 30-35%. It is definitely helping
to define some of the lines, especially around the edges of the dinosaurs, but it is subtle
overall.

8. Add a Levels Adjustment layer > darken the image slightly and brighten a little more just to
pop it up (final image below).

9. Save the photoshop file and then Flatten image > Save as .jpg.
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Zoomed to 100% to see 
effects at finish size
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BONUS CHAPTER

Kindle Kids’ 
Book Creator

Kindle Kids’ Book Creator (KBC) is a new software Amazon released a couple months ago. Its 
sole purpose is to help people create children’s books for Kindle. What makes it interesting is 
not all the cool awesome things it can do. It can’t. But it shows that Amazon is deeply 
committed to bolstering children’s books on their site. It is like Amazon knocking on your door 
saying, “Hey, we really like this kind of book…could you make us some.” 

One of the problems early on in porting illustrated books over to Kindle was the ability to lock 
aspect ratio, fix page widths and things like that which required programming skills that I 
couldn’t understand—and I’m pretty tech savvy. This software alleviates a lot of those 
problems making it possible for authors to get their illustrated books onto Kindle. You can 
import images and either add pop-up text or embed text on top of the images.  

Features of this software include: 

• Supports .pdf, .jpg, .tif, and .png files. PDF is recommended because you can import your
cover and your entire book all at once. They are making the assumption that you have
already published your book in print form so you already have the .pdf. The example we are
going to use here is not going to be using this approach. We are going to build it from
scratch—the harder way to do it—so you can learn how to use it.

• Supports landscape and portrait

• Single page and two page spreads
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GETTING STARTED 

Download the software for either PC or Mac at https://kdp.amazon.com/kids > click on “Get 
Started.” Read some of the information here to learn more about the software. They have a 
Users Guide in .pdf format and you should download it and learn some of the things we won’t 
cover in this training. 

When it comes to using the software to create a book, there are three basic steps: 

1. Import your cover and page images, whether individually as .jpg or .tif, etc. or as an entire
file in .pdf format

2. Add text pop-ups to enhance your book

3. Preview your book to see how it is going to look on an actual device and save for
publishing, i.e. uploading in .mobi format for Kindle.

One of the things I discovered in getting to know the software is there are things they don’t tell 
you. They made some decisions that in their minds made sense. It didn’t make sense to me at 
first, but now I get why they did it and want to explain it. I still think it was a bad decision, but I 
will explain it to you in this training. 

TIPS FOR HOW TO USE 

This is an ASSEMBLY program to output your illustrated book as a .mobi file for Kindle. 
That is all. It is not a design tool so you still need to design your book, come up with your 
illustrations and text. You will need a cover image that is the same size as the illustrations 
based on the format (landscape or portrait, one page or two page spreads) you choose for 
your book. That will determine the orientation of both the cover and for the page 
illustrations. 

For your own sanity, put everything in ONE folder. That means the cover, all the illustrations 
for each page with them titled for the page (e.g. page 1 is [xxx]-01, page 2 is [xxx]-02, etc.) 
so that they are numerically sequenced in your folder. This is design best practice, and it 
will save you a world of frustration in the end. 

The MAXIMUM Image Resolution they have for this software is 3,820px X 2,400px. That 
takes advantage of the highest resolution versions of the Kindle Fire. This is the equivalent 
of a print book of 12.73” x 8” at 300 ppi. So you might think “Great. I can do a print book 
and a Kindle book at one time.” Yes and no as we will see. This is one of their wacky 
decisions. 

Text can be embedded in the image or added in the KBC. 
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ABOUT PAGE SIZES 

You need to understand this… 

The recommended size from Amazon, 3820px x 2400px is equal to a 16:10 aspect ratio. What 
this means is the length of your book is 1.6 times the height if in landscape mode or the height 
is 1.6 times the size of the width in portrait mode. That is all it is. 

This is important to remember because when working with specific, locked-in aspect ratios like 
this and very specific resolution sizes as we have here, that means certain things whenever 
you want to do work once and use it multiple times, e.g. create a book for print, kindle, 
presentation, video, etc. 

Where Amazon’s aspect ratio is 16:10, HD video aspect ratio is 16:9. That means you have 16” 
on the long side and 9” on the high side. So the Kindle book format would be slightly taller (in 
landscape mode as a video would be). That makes it very easy for us to take a book laid out 
according to Amazon specifications for KBC and turn those images into video with a minor 
amount of cropping. 

However, when we go to print, it is a different story because this dimension from Amazon as I 
mentioned earlier works out to a print resolution size of 12.73” x 8”. There is NO print size 
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available on CreateSpace that is 12.73 x 8! You cannot print your book without it being a 
custom size (and then you don’t get expanded distribution, etc.). At first glance, that doesn’t 
make sense. But, here is their logic… a two page spread of an 8” x 10” book is equal to a 
16:10 aspect ratio. So, if you have an illustrated children’s book formatted in standard 8” x 10” 
portrait mode and if you already have two-page spreads in your book layout, this is perfect. 
Your formatted book at 8 x 10 is a standard size for distribution and for print on demand on 
CreateSpace and everywhere else; AND those two pages sitting next to each other perfectly fit 
the aspect ratio Amazon requires for KBC. You want to choose two images side by side in the 
Kindle page designation (see image above).  

The flawed logic here is this: WHY would we want to present our pages on Kindle Fire side by 
side when it makes the pages/images smaller? You are probably going to think this when going 
in to create your book so you need to remember this is why you would need to do it that way.  

However, you do not have to do it this way. If you have a book already at 10” wide by 8” high 
and you don’t want two pages side by side & you don’t want to stretch out the image. That is 
fine. You don’t have to. There will just be a black bar filling each side of the image on screen. It 
is like watching standard definition DVDs on a HD television. 

If you don’t have book formatted at 8” x 10” already or your illustrations aren’t done yet, you 
can make your book any size you want so you can make it fit this aspect ratio. If you have no 
intention of making a physical print copy of your book, and you just want to have it on Kindle 
plus maybe a video, you can go with this format and it works perfectly. 

NONE OF THIS IS IN THE KBC USER GUIDE! 

Demonstration: Creating a book on KBC 
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I’ve written a story and created a number of images using Drag ‘n Drop Illustrator. Now, we are 
going to put it all together using Kindle’s KBC software. 

1. Launch the software. You have two choices: «Launch an Existing Book» or «Create a New
Kids’ Book». Choose «Create a New Kids’ Book» and you get a basic overview of how the
software works and the process. I strongly encourage you to read this.

2. Begin by entering Title and Author, Publisher, Language and location of the folder where
your book is to be
saved. They prefer you
use an empty folder so
you can just create a
new one when you click
«Browse». 

Illustration Kickstart

113



3. Once you save your new folder, you get the following screen to make the three necessary
choices for how you want to lay out your book: portrait vs landscape; two images side by
side or one image at a time; and first page right or left side. If you choose two images-side-
by-side, I recommend you start page 1 on the right side, just as in a print book so you have
continuity with print book standards AND even more important so your two-page spreads
are left to right on screen at the same time as you intend them. Of course, you can choose
“Portrait” and if you do, all those other choices go away. For this book, because I had
already created the images with a 16:10 aspect ratio, I am going to lay this out one image
at a time, landscape orientation.

4. Next, choose to import the entire book as a .pdf or to import just the cover and begin laying
out your book one page at a time in the software. If you’ve already laid out your book in
InDesign or a program like that, it makes sense for you to import as .pdf. I want to show
you exactly how to lay out a book, so I am just going to import the cover > locate it on hard
drive and select > «Start Adding Pages» > from your file where you collected all your book
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assets > select all the images you want to import into the book > «Open». I am not going to 
do the entire story because I don’t have all the images ready, but I have sample 
illustrations for parts of the story and you will see how to put the book together using those. 

5. Once your images are imported, they will show up in a page manager (left side of screen)
with the selected image in the main screen where you can work with it from there to add
text, pop-ups, etc. Images will import in page order according to your file names if you used
the naming convention I taught you earlier.

6. Adding text: I have a document open that has my text written so I will copy the text that
goes with this image > in the top left corner (circled above), we have two options, «add
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pop-up» or «add text». In this case, choose «add text» > highlight the placeholder text in 
text box that appears on screen and paste your text > click on text box and drag to place 
where you want it. When you select the text, you get text tools in the design menu bar so 
you can change the font, size, color, style, etc. Adjust the text box to fit text the way you 
want it and continue to move it around until you have it positioned the way you want it.  

7. Notice there is a little tab that says “View Pop-up” (circled above). What is it? A pop-up is
an enlargement of the text that “pops up.” If you click on the tab, it appears as if nothing is
there (white space right). There really is
something there, the text, but because
the text is in white, it doesn’t show up. To
get around this, click the “View Pop-up”
tab and drag your cursor to select the
text in it > now you can format the text in
the pop-up and reposition where the pop-
up appears when clicked. However, and
this is important, when you select the
pop-up, you will see a new tab that says
“Unlink from page text” (circled). You
need to click on this before you begin to
make any changes to the pop-up text. If
you don’t, the changes will affect the text
on the page also. By unlinking the two,
you can format each one independently.
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So, what happens is, when the reader taps on the text on their Kindle, this pop-up comes 
up on screen in the position where you placed it so they can see the text in larger form. 

8. Choose the next image and repeat the process. The text can be formatted differently for
each page.The next thing we can do is instead of «add text», we can choose the button
«add pop-up». This is different from the pop-up that is associated with your text box. If you
have already embedded the text into your image as in the image below, you wouldn’t want
to add it again here
just so you could get
a pop-up, but you
don’t have to because
«add pop-up» adds
an independent pop-
up that can contain
ANY text content. You
can paste the same
text that is on your
page, reposition the
pop-up (top image
below) and format the
text in it however you
want. One thing you
want to be careful of
is placement of the
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pop-up trigger in relation to your 
text. Not only do you want to 
position the pop-up text for 
where it will appear when it pops 
up, but you want to drag the 
pop-up text trigger box (dashed 
line) to match up over the text 
embedded in the image so when 
the reader clicks on the area 
where the embedded text is, the 
pop-up appears (see bottom 
image right). 

You may also choose to use no 
pop-up. It isn’t required and you 
don’t have to add it if you don’t 
want it.  

NOTE: there are definite 
advantages to embedding your 
text into your images in 
Photoshop before uploading 
because you can add specialty 
display fonts (like with the cover 
image seen above), drop 
shadows and other special 
formatting you cannot add in 
KBC that will become part of 
your image. However, by entering 
your text over the images using the KBC software, the text remains dynamic and editable, 
and it reflows if the reader looks at it on a different, smaller device. 

9. A different, more interesting use of the
«add pop-up» is to use some other
content your reader sees when clicking
on the button. For example, the pop-up
was added over the cow in the image
right. You can add any kind of hidden
text anywhere on the page. Just keep
in mind, there is NO indication in the
final Kindle book that there is a pop-up
associated with the cow. There are no
lines around it, no buttons next to it,
nothing. The only time someone will
see the pop-up is if they happen to tap
the cow. You could include an image
like a star in your illustration with words

Illustration Kickstart

118



saying “tap here for a secret surprise” and then add a pop-up for a little extra part of the 
story or secret message, but that is the only way anyone would know. This only works with 
text. You cannot put an image in the pop-up at the time of this training. 

10. This is all there is to doing a layout for a kids’ book. Just repeat the above steps for each
page of the book. Once finished, you want to click «Book Preview > Create Book Preview»
in the top menu bar. this builds a copy of the book and if you have Kindle Previewer
installed (and you should) it will launch the Previewer and show you what your book looks
like. You can select the device and see how the book will look in each one. Since in the
Previewer on your computer you can’t touch the text to activate the pop-up, you want to
double click and it will work the same as tapping on the device to bring up the pop-up.
Double click again and pop-up goes away.

11. When you use the Previewer, the .mobi file is in the folder you created when you set up
your book. When you are happy with any changes you’ve made, you can use this .mobi file
to upload your book to the Kindle store at kdp.amazon.com.

Advanced Tools 

It is possible for you to make some advanced edits to your document if you aren’t afraid to 
program the HTML text. What we were working in for the layout is the Design Mode but HTML 
mode is also available to you where you can change text attributes, etc. if you know how to 
code the HTML. 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Session Q & A 

Q: Is this new software? 
A: Yes. It has been out a couple of months. 

Q: How long—number of pages—should a kids’ book be? 
A: Average is 32 pages including front and back matter. It works out to 27-28 story pages. 

Q: To be clear, can the two-page 16:10 spread be image on one side and text on the other? 
A: Absolutely. 

Q: What was the program you used to get watercolor effect? 
A: A Photoshop plug-in called SnapArt from Alien Skin Software. 

Q: If I want to create my book in another program and save it as .pdf to import into KBC, 
should my pages be set up in 16:10 ratio? 
A: It depends on how you want your final presentation of the book to be on the Kindle. If you 
want to go single page like I did, then yes, you definitely want 16:10. If you want to use two 
page spreads, then each of your pages needs to be formatted 8” x 10” so two of those pages 
side by side equal the 16:10 aspect ratio. 

Q: After you un-link the pop-up text and make your changes, do you re-link the text? 
A: No. You don’t need to do this. Just leave it un-linked. 

Q: Can you put text into the page in Drag ‘n Drop Illustrator and upload that page to KBC? 
A: Yes. 

Q: If you don’t embed your text in the images, are you limited to Amazon’s basic fonts? 
A: Yes. There are only a few fonts the Kindle readers can read as text. 

Q: Are there any issues with rights of the book because it was created on their software? 
A: No. It is just a tool. Amazon never owns rights to your content. They don’t do that at all. It is 
still your copyright. 

Q: Why would you add a pop-up with the same text? 
A: The Pop-up lets you see the text much larger to make it easier to read, which can be 
important on mobile devices. 

Q: Can you also enter the “Moo” as a sound when tapped? 
A: No. Amazon hasn’t given us the ability to do that. You can add sound effects with Apple’s 
iBooks Author but not on Kindle. 
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Q: If you add a URL in a pop-up, will it be a clickable link? 
A: Excellent question. It is not by default, but it may be possible if you customize the HTML. 

Q: If you sell your KBC-created kids’ book in other platforms. Will it function the same way? 
A: No. This is a Kindle-exclusive software. It is possible to convert a .mobi file into epub. It 
won’t have the pop-up functionality, but the text and images would be there. 

Q: Does this software have to be used only on kids’ books? 
A: No. This software is used only to create a .mobi file that you can upload to Kindle. That is 
all. What you put into that file is irrelevant. ANY kind of illustrated book can be created using 
this software. You could create recipe books and have fun with the pop-ups. It was just 
designed to be used to make it easier for kids’ book authors since that is what is most often 
illustrated and illustrated books presented the most challenges with Kindle book creation. 

Q: In the pop-up block, can you format the background or is it always going to be white. 
A: From all I’ve been able to see in the current version, the background cannot be formatted 
unless you can do it in the .css files that are created when each page of the document is 
generated. You need to know some programming to do this, but I don’t know if even that would 
work. I haven’t tested it. 

Q: Are there delivery fees? 
A: Yes. There are still delivery fees and that is a consideration, but what Amazon says are the 
delivery fees for the bigger books and what they really are is not the same in reality. I found 
that in my calculations of what delivery fees should be based on their formula compared to my 
real royalty payouts, the delivery fee they charged me was significantly smaller. 

Q: How does this handle table of contents, bookmarks, etc. that are in other Kindle books? 
A: You can add those, but how many children’s books have you seen that have a TOC if not 
compilations. 

Q: Is there a minimum and/or maximum page count? 
A: There is probably a maximum, but I don’t know what it is. I’ve created .mobi files as small as 
two pages out of this software—and you are not going to sell a two page book, so… 

Q: I have a black and white book. Will it still work? 
A: It makes no difference. 

Q: Do you need to use pop-ups on each page? 
A: No. You don’t have to use them at all.

Illustration Kickstart

121



NOTE: For much more information, get the free download on Public Domain Children’s Books 
at http://easybookillustrations.com/childrens-books-in-the-public-domain/ 

VINTAGE CHILDREN’S BOOKS: WHY DO OLD BOOKS MATTER? 

✦ These books provided the foundation for millions of adults. Think about all the children’s
books produced from the beginning of printing up to the point that represents the public
domain, pre-1964. These were the stories of our parents, grandparents and great-
grandparents all of whom had access to those books in one form or another. We tend to
think newer is always better, and in some cases that is true, but it doesn’t discount what
came before because that is what laid the foundation.

✦ Disney has been spectacular about using old stories and making them fresh and new, but
that doesn’t mean the opportunities no longer exist. It is easy to get locked into the idea
that someone already did it. No way. They haven’t even come close.

✦ These books are often beautifully illustrated. The technology available at the time and the
techniques they used very often gave way to very beautiful illustrations. We cannot begin to
reproduce that quality with the technology we have today.

✦ Nostalgic messages from another era, the underlying stories and values, are timeless. Yes,
we might change up the frame of reference, some names, settings, and other details to
reflect the world around us, but the essence still remains the same and the messages are
still applicable today.

BONUS CHAPTER

Public Domain 
Children’s Books
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We can use the stories and illustrations however we choose. We get to bring back those 
stories for a new generation of children without having to ask permission. Technically, we don’t 
even have to change anything, but I recommend you create a derivative work. It is easier to 
start from something than to start from scratch, but you should never minimize the notion that 
you have something to offer the world by just putting out a duplicate of something that is really 
someone else’s voice. Why not draw from your own creativity, inspiration, and voice to add that 
“something” to the products you create from this foundation? 

FINDING CHILDREN’S BOOKS 

ONLINE: In most of these, you will be able to download high-resolution versions of the images 
and the stories. 

✦ International Children’s Library, http://www.childrenslibrary.org

✦ Literature for Children, http://palmm.fcla.edu/juv This is part of the State University Libraries
of the State of Florida. Access to content here is not ideal, but they have a lot of great
books and you should make the effort.

✦ Children’s Literature from the Rare Book & Special Collections Reading Room (Library of
Congress), http://www.read.gov/books/index.html#kids. There aren’t a lot of books on this
site and there is some overlap with content on other sites but what is on this site is first-
rate.

✦ Baldwin Library of Historical Children’s Literature, http://ufdc.ufl.edu/juv

✦ 19th-Century Girls’ Series, http://www.readseries.com. If you have daughters, you may
have seen how popular doll series like American Girl Dolls are. A lot of the books here are
pre-cursors to American Girl.

✦ Nineteenth-Century American Children and What They Read, http://www.merrycoz.org/
BOOKS.htm

OFFLINE: 

✦ Used Bookstores. There are so many great treasures tucked away in used book stores.

✦ Antiques Markets

✦ Book Shows and Sales. You can find the large fairs around the country at
booksalefinder.com. These sales are crazy fun. You must go prepared and that includes a
smartphone with a page opened to copyright.gov so you can check the copyrights; take a
portable cart with boxes and/or bags; if you are at a super big show, grab first and figure it
out later. If you don’t, other people will.

✦ eBay

✦ Abebooks, www.abebooks.com. If you like books and haven’t been on this site, you need to
fix that right away! They have great search options in the site so click on “More Search
Options.” You can type in minimum and maximum publishing dates (e.g. to get public
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domain dates) and type in keywords like “illustrated children” to get tens and sometimes 
hundreds of 
thousands of books. 
In the search results, 
I usually go to the 
most expensive first 
(which could be 
millions of dollars) 
because that can 
help you identify the 
books and then you 
can look for them in 
other places. Very 
often you can pick 
up books very 
cheap. 

✦ National Archives, https://archive.org, is a most amazing site. Type in keywords into the
search field and choose texts from the drop down. In the search results, click on a book title
to read it online or download. Some have illustrations, some are just black and white. This
site is very good about telling you exactly which content is public domain and which is
protected by copyright.

Demonstration: ABC books 

I did a search on this site for “ABC books.” Click on any one. They don’t tell you a lot about any 
book, but they tell you the form they have it in on the site (i.e. pdf for the book below). I’ve 
found they have on this 
site two formats, .pdf 
and .jp2, a modified 
version of .jpg that lets you 
zoom in on the images 
online.  

You will notice when you 
choose a book record 
(below) from the search 
results, it is not clear what 
you can do with the book. 
There is a save button, but 
that is to save a copy of 
the record. If you click on 
the image of the book, 
either in this record or in 
the search results, it will 
open a viewer and take 
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you to the scanned content and covers of the book.  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You are provided with 
an icon (circled) to 
download the .pdf. It 
will not save the entire 
document, just the 
page you are looking 
at, but at least it saves 
the .pdf in the highest 
resolution and you 
can open this in 
Photoshop. 

I’ve found, however, 
that on this site, most 
content is saved in the 
.jp2 format. The 
downside is that 
unless they give you a 
clear downloadable 
solution, you cannot 
download them—the 
reason so many sites 
are using them now. 

NOTE: There is a work-around to the download problem for .jp2. When you are browsing and 
look at a .jp2 file online, while 
you are looking at it, the 
browser loads the file for 
you to zoom in on and look 
at, but the important thing is 
the complete version of 
the .jp2 file is being held 
inside the temp internet 
folder for your browser. This 
temp folder flushes its 
contents as soon as you 
stop browsing. Some 
browsers (I think Firefox 
works) let you set them so 
not to automatically flush the 
temp files. If you know 
where the folder is (show 
hidden files and do a search 
for it on your hard drive), 
you can access those .jp2 
files. 
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Demonstration: Children’s Literature, Library of Congress 
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Clicking on the link “More About this Book” for The Children’s Object Book, takes you to a 
description page where you can view/download a .pdf or View the html file. >  

Click “View HTML” > Higher Quality 
Images > on page that loads with the 
higher quality image, scroll to the bottom 
where you can click on and download 
the image in jpeg or tiff. Alternatively, 
you can right click on pages as you view 
them to download. 
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Clicking on the link “Read This Book Now” from the search results, you will see a page turn 
version of the book. As you flip through the pages of the book, you can zoom in (circled). You 
can right click and choose “Open image in new tab.” This will load the full version, page by 

page, of the image which you can then right click and “save image as” to download to your 
computer.  You can also view and download the pdf.  

At The Library of Congress, they go out of their way to make it easy for us to get access to the 
public domain works they have. 
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Demonstration: Baldwin Library of Historical Children’s Literature 

Since the first site we looked at, Literature for Children, is the Archival site of the State of 
Florida university libraries and this site is part of the University of Florida libraries, it naturally 
has has many of the same books that the Literature for Children site has. However, it also has 
a lot of additional works, too.  
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Type in ABC in search box and you get a page like this: 

You can do a brief view, thumbnail view or table 
view. Looking at thumbnail view (right), they 
show you the books and you will notice that 
sometimes, there are multiple editions. It is the 
same book but they might be in different 
condition. 

What is really cool about this site is when you 
choose a book, you can go through the pages of 
the book and see where it says”Click on image 
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below to switch to zoomable version? Do that and continue clicking on the larger and larger 
version until it stops getting larger on screen. Then, you have access to the largest version and 
can right click > Save Image As to save to your computer. It will only save the image based on 
the size you have on the screen so you want to click it until you reach the largest size before 
downloading. 
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PRODUCT CREATION OPTIONS 

✦ Printed Books. You may have to typeset the books in some cases or work with the images
a little, but CreateSpace makes creating new printed books easy. Be willing to do things
others won’t because it gives you the edge.

✦ Kindle Books

✦ Dynamic Books. You can do things like embedding audio and videos, etc. into the digital
book like you can with iBooks Author. These work like apps on your devices.

✦ Audio Books and Audio Book Collections.

✦ Comics. You can take illustrated books and turn them into comics, taking one form and
turning it into another.

✦ Collections. These can be collections of books on dvd, collections of images from books on
dvd, etc. I don’t recommend doing this, but some people have really knocked it out of the
park with this. If you do it, make it as niche specific as you can.

✦ Framed Prints. Use the illustrations from old books.

✦ Scrapbook backgrounds and elements.

✦ T-shirts. Teespring and other crowd-funded t-shirt sites are all the rage right now. You can
use images from old books to create t-shirt designs for these.

✦ Toys and Plush. This is a bit more of a jump, so you want to do a lot of market research, but
if you take characters and update them to make them your own, you can create a toy line
from those characters.

✦ Stock Images and Graphics. I wouldn’t recommend uploading children’s illustrations to
iStockPhoto or Dreamstime, but there are other options. You can clean up the image and
sell bundles yourself on your website or something along those lines.

✦ Custom fabric, wallpaper, decals and gift wrap. www.spoonflower.com makes this easy to
do. I’m sure you can search the site and find fabric patterns based on images from the
public domain. You can use the fabric to make other things, like dolls or tote bags.

✦ Make your own dolls. You don’t just have to print fabric and make stuffed dolls. You can use
clay or wood pegs, etc. to create physical dolls. You can also consider finding character
ideas in the old books, creating a version of those characters for yourself, and then putting
those characters into scenes you photograph and illustrate for a new children’s book.
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SOME IDEAS TO GET YOU STARTED 

GET CREATIVE! Look at this image from The Children’s Object Book. 

The Kindle comic creator software has the ability to zoom in on panels, primarily because of 
comic panels, but there is nothing saying you can’t create a panel for each of these objects so 
that when the child touches cat, for example, the cat zooms out. THINK ABOUT THIS. 

The image here (right) is like a flip doll but because you 
have both the front and back of two animals, it wouldn’t be 
hard to take these and use them on Spoonflower to create 
a stuffed doll printed on fabric that someone could cut out, 
sew and stuff. 
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Here are some other great examples of what you can find in these books…  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Session Q & A 

Q: How old does a book have to be to be in public domain? 
A: In US, if it is before 1923, it is automatically in the public domain. About 80% of the books 
published between 1924 and 1964 did not have their copyrights renewed in the 28th year after 
publication as required and are thus also in the public domain. www.provencontent.com/
resources > scroll down to bottom of page and there is a page called “Copyright Research.” 
This goes into detail on how to do copyright research. There is also a downloadable .pdf 
explaining all the steps, regardless of what you are trying to research. 

Q: If we find a book on these sites, can we guarantee it is in the public domain? 
A: Yes. 

Q: Is only a small fraction of the public domain children’s books available online and you have 
to find the bulk of them using offline resources? 
A: That would be my estimation. There are over 85 million books in the public domain in the 
US alone and only an estimated 5 million online. Applying this same kind of ratio to children’s 
books as a subset of this total book number, you have to assume that is the case. That is why I 
spend a lot of time going to book fairs and used bookstores. 

Q: In the Mad Illustrator webinar a couple of weeks ago, you mentioned a photo editor 
software costing less than $50… 
A: It wasn’t a photo editing software but a photo illustration software and if you are in the Easy 
Book Illustration Foundations class, I demo’d that this past week. I am not sharing it publicly. 

Q: Where do you find public domain songs? 
A: Music falls under a different category than any other public domain content because it is 
governed by state law rather than federal law in the US. That changes things a lot, and there is 
not a lot of music in the public domain. You can find some on the Library of Congress site and 
there is a site called musopen.org where a group of folks are taking orchestral music to military 
and high school bands, having them play it, recording it and putting the recordings back into 
the public domain. There is a lot of sheet music in the public domain, and a simple Google 
search will find those. 

Q: I found an article that clearly said it was public domain but also said it could not be sold for 
a fee. Is that possible? 
A: Yes and no. There are sites, especially museums, that offer public domain stuff and say you 
can’t use it for commercial purposes. The way the law is, the really cannot do that. There have 
been numerous lawsuits where judges have ruled in every case that the copyright on this 
cannot be limited so those works are still in public domain. Here is the spin… let’’s say I find an 
original painting by Renoir. I buy it. Obviously, it would be in the public domain. However, I 
physically own that painting. As the owner of the physical property, I have the legal right to limit 
access to it, meaning if you want to copy it, I can make you pay a licensing fee. I am within my 
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legal right to do that. Things in the digital realm are different because they are exact copies of 
the original and the duplicator cannot limit its use as a public domain work unless they have a 
very clear licensing policy on the site that you have to agree and click to agree in order to view 
it. One thing you can do for a written work like this article is copy a random sentence from it, 
put it in quotes in a Google search and see if it shows up anywhere else. If it does, chances 
are you can use it from a different site instead. 

Q: What does Google do with scans they make of works that are still in copyright? 
A: Usually they make them available on the site in limited form and generally show some kind 
of “Look Inside” type preview with links where you can purchase at various sites. At 
books.google.com search for something like “illustrated kittens.” You are going to get a lot of 
results including some that are still protected by copyright. To narrow your results to books you 
can use from the public domain, click “search tools” > “any books” drop down arrow > free 
google ebooks. This resets the search results to books/magazines in the public domain. 

Q: If you find a public domain book and upload to Kindle, do you have to list it as public 
domain? 
A: Yes, if you didn’t change it. If you don’t make it your own, you cannot claim it or prevent 
others from publishing it as well. 

Q: Does “No Public Domain” on Amazon apply to printed books? 
A: Yes. If it is not available anywhere else, you can usually upload it, but if the book is 
available for free anywhere else, you cannot put it on Amazon. 
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